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About this workbook 

Welcome to this Infor Education course! We hope you will find this learning experience enjoyable and 
instructive. This Training Workbook is designed to support the following forms of learning: 

 Classroom instructor-led training 

 Virtual instructor-led training 

 Self-directed learning 

This Training Workbook is not intended for use as a product user guide. 

Self-directed learning (SDL) 

If this course is eligible for self-directed learning, demos and exercises throughout this Training Workbook 
will be hyperlinked to Demonstration/Let Me Try simulations. In these instances, clicking the hyperlinked 
title launches simulations that allow you to view and practice the execution of the demo or exercise in a 
simulated training environment.  

Activity data 

You will be asked to complete some practice exercises during this course. Step-by-step instructions are 
provided in this guide to assist you with completing the exercises. Where necessary, data columns are 
included for your reference. 

Your instructor will provide more information on systems used in class, including server addresses, login 
IDs, and passwords. 

Symbols used in this workbook 
 

 

Hands-on exercise 
(“Exercise”) 

 

For your reference 

 

Instructor demonstration 
(“Demo”) 

 

Your notes 

 

Can be used for either 
“Scenario” or “Discussion” 

 

Question 

 

Note 

 

Answer 
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Course overview 

Reference materials 

Reference materials are available from the following locations:  

 Help menu 

 Infor Xtreme®  

Course duration 

8 hours 

Learning objectives 

Upon completion of this course, you will be able to:  

 Describe how to set up the parameters required for repetitive manufacturing. 

 Discuss how to maintain the work center records. 

 Describe how to set up the criteria required for production items and component materials for 
repetitive manufacturing. 

 Describe how to copy and manipulate routings and bills of material. 

 Explain how to generate production schedules. 

 Describe how to update production schedules. 

 Explain how to manage the supply of floor stock locations. 

 Describe how to record production schedule transactions. 

 Describe how to record just-in-time production and work center transactions. 
 

Audience 
 Customer User  

 Pre-Sales Consultant  

 Business Consultant  

 Technical Consultant  

 Support 

System requirements 
 CloudSuite Industrial 9.00.20 PLUS Training Environment 

Prerequisite knowledge 

To optimize your learning experience, Infor recommends that you have the following knowledge prior to 
attending this course: 

 Knowledge of foundational concepts 

 Knowledge of how data is structured and organized  

 Ability to navigate the user interface 
 



 

   Using Production Schedules and JIT/Kanban Training Workbook 7 
   © 2016 Infor Education 

Course description and agenda 

This course provides an overview of repetitive production control system and lists the factors to consider 
for its implementation. It also covers the setup for repetitive manufacturing, the use of operation control 
points and backflushing, creation of standard and production schedule BOMs, development and 
implementation of a production schedule, and the repetitive manufacturing processing.  

Prerequisites:  

 CloudSuite Business / CloudSuite Industrial: v9 Managing Inventory 

 CloudSuite Business / CloudSuite Industrial: v9 Using Bill of Materials & Engineering Change 
Notices (BOM/ECN) 

Lesson Lesson title Learning objectives Day 

Course overview Review course expectations. 1 

1 

Introducing the 
repetitive 
production control 
system 

Summarize the repetitive production 
control system. 

Compare the production control 
processes. 

1 

2 
Setting up 
repetitive 
manufacturing 

Identify work center settings needed for 
repetitive manufacturing. 

Describe how to set up a scrap account. 

Describe how to set up a floor stock 
location. 

Explain how production items and material 
items must be set up to support repetitive 
manufacturing. 

1 

3 
Backflushing and 
control points 

Describe how control points and 
backflushing are used in production 
schedule processing. 

Identify the steps to set up control points 
and backflushing for an item routing. 

1 

4 

Creating standard 
bills of materials 
(BOMs) for 
repetitive items 

Describe the process to create a current 
BOM for a production item in repetitive 
manufacturing. 

Determine the “Pieces per Hour” rate for a 
routing operation. 

Identify the utilities and the sequence they 
are used to create a standard BOM. 

1 

5 
Creating 
production 
schedules 

Order the steps to define a production 
schedule for repetitive manufacturing. 

Identify the BOMs that are needed for 
production scheduling and describe the 
processes in which they are created. 

1 
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Lesson Lesson title Learning objectives Day 

6 
Production 
schedule 
processing 

Explain the process for replenishing floor 
stock locations. 

Identify the transactions that are used for 
production schedule processing. 

Describe the steps for recording 
completion of production schedule 
finished goods and scrap inventory. 

Identify the reports that are generated to 
monitor production schedule finished 
goods. 

1 

7 Other transactions 

Determine when work center transactions 
should be used. 

Explain how just-in-time (JIT) transactions 
are recorded. 

Explain how work center transactions are 
recorded. 

1 

Course summary Debrief course. 1 
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Appendices 

There are appendices at the end of this Training Workbook that you may find useful. They contain 
information that is not part of the instructional content of this course but provide additional related 
reference information.  

Appendix Appendix title Content description 

Appendix A Review scenario 
A comprehensive scenario for practicing the concepts and 
procedures learned in the course 

Appendix B 
Reports and 
utilities 

 Various repetitive manufacturing reports with a description 
of each report’s output  

 Reports introduced in this course  

 Various repetitive manufacturing-related utilities with a 
description of each utility’s purpose 

Appendix C 
Additional 
implementation 
information 

Information describing additional factors for consideration 
when implementing repetitive manufacturing 

Appendix D 
Summary of 
planning tools 

A summary of the various manufacturing planning tools  

Appendix E Form navigation 
Forms that are used for repetitive manufacturing and where 
they are found 
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User interface 

Standard user interface elements include the top navigation pane menus and the main toolbar. 

 

Navigation pane menus and main toolbar 

Navigation pane menus 

You can browse all available folders through the navigation pane menus and submenus. Hovering your 
mouse over each of the navigation pane menus allows you to explore the submenus contained beneath.  

 

Navigation pane menus and submenus 

You can pin submenus to the navigation pane. For example, if you know that you will be using the 
Customer Service submenus frequently, you can display the menus at the top level, by pinning them to 
the navigation pane. 

Main toolbar 

The main toolbar contains icons that allow you to quickly complete commonly used tasks, such as saving 
data or closing a form. You can position your mouse pointer over an icon on the toolbar to reveal its 
description and functionality. 

Keyboard shortcuts 

Some navigation pane submenus display available keyboard shortcuts that can be used to save multiple 
steps when completing certain tasks.  

 

 



 

   Using Production Schedules and JIT/Kanban Training Workbook 11 
   © 2016 Infor Education 

 

Keyboard shortcuts 
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The following table displays the available shortcut keys and their actions. 

Shortcut keys Action 

Navigating Forms 

Ctrl + F4 Close current form. 

Ctrl + O Open Select Form. 

Ctrl + W Open workspaces. 

Ctrl + Tab Switch view to next open form. 

Navigating records 

Ctrl + Home Move to first editable field of form. 

Tab Move to the next field. 

Shift + Tab Move to the previous field.  

F8 Move to the next record. 

F7 Move to the previous record. 

Ctrl + F8 Switch the next collection on the form to become the current collection in a form 
that contains multiple collections. 

Ctrl + 1 Hide/Show 1st Splitter Pane. Toggles the first splitter pane between being hidden 
from view and being shown. If the form contains a vertical splitter bar, the first 
splitter pane is the left pane. For a form that is split horizontally, the top pane is the 
first splitter pane. Alternatively, select System > View > Hide/Show 1st Splitter 
Pane. 

Ctrl + 2 Hide/Show 2nd Splitter Pane. Toggles the second splitter pane between being 
hidden from view and being shown. On a form with a vertical splitter bar, the 
second splitter pane is the right pane. For a form that is split horizontally, the 
bottom pane is the second splitter pane. Alternatively, select System > View > 
Hide/Show 2nd Splitter Pane. 

Editing records 

F2 Activate the drop-down list with an implied asterisk (i.e., wildcard) after the entered 
text in the field to then populate the list with data entries that begin with the 
entered text. 

Ctrl + N Add new record. Alternatively, select System > Actions > New. Note: The Actions 
menu is only available when a form is open. 

Ctrl + A Add value for current field. Alternatively, select System > Edit > Add. 

Ctrl + C Copy 
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Shortcut keys Action 

Editing records, continued 

Ctrl + X Cut 

Ctrl + V Paste 

Ctrl + Z Undo. Alternatively, select System > Edit > Undo. 

Ctrl + D Delete record. Alternatively, select System > Actions > Delete. Note: The Actions 
menu is only available when a form is open. 

Ctrl + F Find value for current field. Alternatively, select System > Edit > Find Value for 
Current Field. Note: This is only accessible for certain field types, such as some 
drop-down lists. 

Ctrl + L Display details for current field drill down. Alternatively, select System > Edit > 
Details for Current Field. Note: This only works for certain field types, such as 
some drop-down lists. 

Ctrl + S Save changes. Alternatively, select System > Actions > Save. Note: The Actions 
menu is only available when a form is open. 

Filtering records 

F3 In Filter In Place mode, cancel the filter in place and return to the collection 
previously displayed. Alternatively, select System > Actions > Filter > Cancel in 
Place. 

F4  In Refresh/Run mode, begin filter in place (i.e., clear the collection and go back 
to Filter In Place mode). Alternatively, select System > Actions > Filter > Begin in 
Place. 

 In Filter In Place mode, execute in place (i.e., run the filter). Alternatively, select 
System > Actions > Filter > Execute in Place. 

F5 
 In Refresh/Run mode, refresh the current collection. Alternatively, select System 

> Actions > Refresh. 

 In Filter In Place mode, clear the filter in place. Alternatively, select System > 
Actions > Filter > Clear in Place. 

Ctrl + F5 In Refresh/Run mode, refresh the current record. Alternatively, select System > 
Actions > Refresh current. 

Ctrl + F2 In Refresh/Run mode, repeat Find Value in Collection. Alternatively, select System 
> Edit > Repeat Find. 

Ctrl + Q In Refresh/Run or New mode, open associated query form to specify filter criteria. 
Alternatively, select System > Actions > Filter > By Query. 
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Other 

F1 Open field level help topic. 

Ctrl + E Toggle design mode on and off. Alternatively, select System > Edit > Design 
Mode. 

Ctrl + P Print 

Field types 

The following tables display the field types available with a brief description: 

Field type Description 

Required, system-generated, and read-only fields 

 
 Any field that is required will have a red star 

 A system-generated field will have a green star  

 A field with no border around the data is read-only 

Standard GUI fields 

 Check box indicating Yes or No 

 
Radio button to select one option from multiple choices 

 
Drop-down list to select one option from multiple choices 

Forms and reports 

Basic elements include forms and reports. Forms provide an organized view to the data stored in the 
database. Just about everything you do uses a form element. You use different types of forms depending 
on whether you need to add new information, modify existing information, or view the details of a specific 
record.  

 Forms are made up of records that contain multiple fields of data. Records consist of a group of 
related pieces of information. Fields are the basic elements that display the related data pieces 
and are grouped together to make up a record. 

 When a form displays multiple records, it is referred to as a collection. A collection displays 
multiple records that have some commonality. 

Reports are used to organize and present filtered collections of related data.  

 

 



 

   Using Production Schedules and JIT/Kanban Training Workbook 15 
   © 2016 Infor Education 

Lesson 1: Introducing the repetitive 
production control system 

Estimated time 

40 minutes 

Learning objectives 

After completing this lesson, you will be able to: 

 Summarize the repetitive production control system. 

 Compare the production control processes. 

Topics 
 Overview 

 Repetitive process flow 

 Production control processes 

 Will repetitive manufacturing work for you? 

 Demo: Production schedule processing 
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Overview 

Manufacturing production control systems can be grouped into three categories: 

 Flow manufacturing 

 Intermittent manufacturing 

 Project manufacturing 

Flow manufacturing includes repetitive manufacturing (units are discrete, e.g. appliances) and continuous 
manufacturing (goods made in continuous flow, e.g. gasoline). The table below shows which module 
supports each system. 

Manufacturing category  Module 

Flow (repetitive) Production schedules 

Just-in-time (JIT)/KANBAN 

Intermittent Job orders 

Project Projects 

Manufacturers in a hybrid or repetitive environment organize sections of the shop floor differently from a 
traditional job shop. In the hybrid or repetitive environment, work centers will be grouped together into 
cells with objectives of achieving manufacturing efficiencies and reducing non-value added tasks, such as 
move time between operations and unnecessary material handling between work centers. This allows a 
more flow-like manufacturing pattern to emerge. 

 

In this training workbook, the term cell is used in the same manner as assembly line or 
production line. 



 

   Using Production Schedules and JIT/Kanban Training Workbook 17 
   © 2016 Infor Education 

Repetitive process flow 

To use the system to support your repetitive processes, you'll follow the procedure below. In this class, 
you will perform each step. 

 Set up resources to model your production lines or cells. 

 Set up work center costing accounts. 

 Flag items to be manufactured repetitively. 

 Set up scrap account on product codes. 

 Set up backflushing and control points in the current routings/BOMs. 

 Set backflush locations for materials. 

 Create standard BOM for each repetitive item. 

 Create production schedule (PS), PS items, and PS releases. 

 Release production schedule lines. 

 Record production schedule and work center transactions. 

 Run end of period costing. 

 

 

______________________________________________________________________ 
 
______________________________________________________________________ 
 
______________________________________________________________________ 
 
______________________________________________________________________ 

 

______________________________________________________________________ 

 

______________________________________________________________________ 

 

______________________________________________________________________ 
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Production control processes 

The chart below compares key functions of the systems repetitive and intermittent systems. 

Function Job orders Production schedules JIT/Kanban 

Costing method Job costing actual or 
standard 

Process costing 

standard 

Process costing 

standard 

Cost 

accumulation1 

By Job/operation To work center To work center 

Scheduling APS (backward) 2 

Scheduling (forward) 

APS (backward)  

Scheduling (forward) 

APS (backward)  

Scheduling 
(forward)3 

Capacity 

management 

Resources Resources Resources4 

Engineering change notice 
(ECN) control 

Yes No No 

Routing/Bill of 

Material (BOM) 

Current 

Job 

Current 

Production schedule 

Standard 

Current 

Production By Job By Item 

By Production schedule 

By Item 

1 Accumulated costs include direct labor,  materials and machine, labor, and materials overhead 
allocations. 

2 APS = Advanced Planning System module 

3 While you control flow using Kanban, you can still plan and schedule planned orders to provide 
dispatch and see capacity. 

4 You can see the planned and scheduled resources for planned orders. 
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Will repetitive manufacturing work for you? 

Ask yourself the following questions to help determine if the systems repetitive manufacturing processes 
will work for you. 

 Do you have products or families of products that are made repeatedly? 

 Do the costs for these products not fluctuate so that standard costs can be implemented? 

 Are production rates and BOM data for these products accurate? 

 Is work center-level cost visibility for these products sufficient? 

 

 

With repetitive manufacturing you do not have the ability to view costs at the item 
level; costs are viewed at the work center level. 

 Do you have the flexibility so that job orders can still be used for other items (product lines)? 

 If you can answer “Yes” to all of the above questions, it is likely that you can utilize the systems 
repetitive manufacturing processes. 

 

 

Demo: Production schedule processing 

Your instructor will demonstrate some typical production schedule processes so that you 
can get an idea of how production schedules are used for repetitive manufacturing. 

 

 

______________________________________________________________________ 
 
______________________________________________________________________ 
 
______________________________________________________________________ 
 
______________________________________________________________________ 
 

 

 

Exercise 1.1: Production schedule processing 

In this exercise, you will work with some typical production schedule processes so that you 
can get an idea of how production schedules are used for repetitive manufacturing. 

Exercise 1.1 steps 

Part 1: Create a production schedule for the MB-10000 

1. Select Master Explorer > Modules > Production > Production Schedules > Production 
Schedules to open the Production Schedules form.  The Production Schedules (Filter In 
Place) form opens. 

 Click Filter In Place on the toolbar to turn off the filter-in-place mode. 

The Production schedule PS00000001 record displays. 

 There are two parts to a production schedule – the header and the items being produced 
under the schedule. More than one item can be manufactured on same schedule.  
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 With job orders there is something called co-products. Production schedules are much 
simpler than co-products. The reason that the two items are in the same production schedule 
is that they are run on the same assembly line. You might group them by families of items, by 
schedulers, etc. 

 Click Items/Releases.  

The Production Schedule Items form opens with item MB-10000 displayed.  

 Here you can view the schedule of what is going to be produced. All of the scheduled 
releases and due dates for the MB-10000 are listed in the grid. A production schedule can 
stay open forever. It is the releases that are closed over time. 

 Click the X on the tab of the Production Schedule Items form to close the form. The 
Production Schedules form should be the active tab. 

 Click Create new object in the current collection. 

 Click Save. The system assigns the next sequential Schedule ID. 

 Click Items/Releases. The Production Schedule Items (Linked) form opens. 

 Select MB-10000-Bicycle,Model-180,Mountain,Black/White from the Item drop-down list. 

 Click Save. 

There is now a BOM for the production schedule item as shown by the selection of the “PS Item 
BOM Exists” check box. 

 Select a date <one week from today> in the Due Date field of the first line in the grid. 

 Type 40 in the Released field.  

 Select a date <two weeks from today> in the Due Date field of the second line in the grid. 

 Type 60 in the Released field. 

 Select Released from the Status drop-down list on line 1 of the grid. A dialog box opens 
displaying the message: [Change Production Schedule Release Status] will be performed for 
Production Schedule Releases that has [Schedule ID: PS00000011] and [Item: MB-10000] and 
[End Date: 10/29/2014]. 
 

Status is Planned and will be Released.” 

 Click OK. A dialog box opens with the message, “[Copy Routing BOM] will be performed.” 

 Click OK.  

 

There are other ways to copy the BOM to the production schedule releases, or a 
BOM can be manually created. 

 Select Released from the Status drop-down list on line 2 of the grid. A dialog box opens with the 
message, “[Change Production Schedule Release Status] will be performed for Production 
Schedule Releases that has [Schedule ID: PS00000011] and [Item: MB-10000] and [End Date: 
10/29/2014].” 
 
Status is Planned and will be Released.” 

 Click OK. A dialog box opens with the message, “[Copy Routing BOM] will be performed.” 

 Click OK. 

 Click Save modified data and close form (OK). 
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This production schedule has nothing to do with the Master Production Schedule in 
planning and other production schedules in planning. They are planning tools but 
they are not shop floor control tools. 

 
A production schedule has been created. If you use the Advanced Planning System (APS) or the 
Material Requirements Planning (MRP) modules, they will create planned orders and suggestions 
for you and you will be able to firm those up, just like you firm up planned orders into jobs. It will 
also firm them up into releases here on any given production schedule. Once you have it all set 
up, the next step is to record the pieces completed. 

 Close the Production Schedules form. 

Part 2: Complete a quantity of 20 for MB-10000 

1. Select Master Explorer > Modules > Production > Production Schedules > Activities > 
Production Schedule Complete Transactions.  The Production Schedule Complete 
Transactions form opens. 

 Type MB-10000 in the Item field. 

 Type 20 in the Completed field. 

 Select the [production schedule that you just created] from the Schedule ID drop-down list. 

 Select PS-FRM from the Work Center drop-down list. 

 Click the tab for the Production Schedule Items (Linked) form. 

 Click Release Operations. The Production Schedule Release Operations (Linked) form opens. 

 

Repetitive manufacturing is to produce something that you know how to build, so 
backflushing can be used. Notice the Work Center and the Backflush fields. 

 Select each of the operations from the list in the left panel. 

 

All of the operations are set to backflush and some of them are set as control points 
so you don’t have to record them as complete for backflushing to take place. 

 Click the Materials button. The Production Schedule Release Materials (Linked) form opens. 

 Since you know how much material is used for an operation, you can backflush materials as 
well. 

 If there are overtime hours, then you have to enter that time in addition to what is being 
backflushed. Also, if you use more materials than what is called for in the BOM, then you will 
have to enter those transactions.  

 Go back to the Production Schedule Complete Transactions form.  

 Select 1 – Daniels, David from the Employee drop-down list. 

 Click Process. A dialog box opens with the message,  

 Click OK. 

 Display the Production Schedule Items form and refresh the form. 

 View the Completed field for the first release. 

The Completed field will only keep a count on the number of items that completely went through 
the entire bill of materials. Completion was recorded for 20 items only through operation 20 (two 
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operations). Completion of all four operations of the BOM would have to be recorded for the 
Completed field to be incremented. 

This demonstration was a good look at the repetitive manufacturing operation. You can see how you are 
able to save a lot of time compared to job orders processing. With job orders, the work-in-progress (WIP) 
costs roll up to the job order, etc. In repetitive manufacturing, all of the costs are rolled up to the work 
center.  
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Lesson 2: Setting up repetitive 
manufacturing 

Estimated time 

40 minutes 

Learning objectives 

After completing this lesson, you will be able to: 

 Identify work center settings needed for repetitive manufacturing. 

 Describe how to set up a scrap account. 

 Describe how to set up a floor stock location. 

 Explain how production items and material items must be set up to support repetitive 
manufacturing. 

Topics 
 Introduction 

 Setting up work centers 
o Scheduling 
o Accounts 
o Variance 
o Overhead accounts 
o Resource groups 

 Setting up a scrap account 

 Setting up a floor stock location 

 Setting up items for production 
o Item fields to modify 
o Activate backflushing for materials used in production 
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Introduction 

When using repetitive manufacturing, there are some setup tasks that need to be completed. 

 You will be using production schedules to support your repetitive manufacturing. Before you build 
a BOM and release production schedules, you need to: 

 Set up work centers to support the process costing. 

 Set up items to support production schedules.  

The table below summarizes the setup tasks that need to be completed. 

On this form... Set up... 

Work Centers WIP, variance, and overhead accounts 

Control points 

Backflushing defaults 

Product Codes Scrap account 

Location Floor stock locations 

Items Cost type 

Production type 

Backflushing default 
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Setting up work centers 

When using repetitive manufacturing, there is some setup that needs to be done. Let’s start with the Work 
Centers form. Since costing is done at the work center level, we need to populate the WIP accounts on 
the Accounts tab, the variance accounts on the Variance tab, and the overhead accounts on the 
overhead accounts tab. Also on the Scheduling tab you need to review the settings for backflushing.  

Repetitive manufacturing assumes that you are going to backflush labor and machine as much as 
possible so it is important to set backflushing and control points for these work centers.  

Control points in a routing minimize the number of entries required to record production. Reporting 
production complete can only occur at control points when using production schedules. The last operation 
for a production schedule routing should be designated as a control point. More detail on the use of 
control points is presented in the next lesson. 

To add a new work center record to the system, you would open the Master Explorer > Modules > 
Production > Work Centers > Work Centers form. Once opened, you can add a new record and enter the 
appropriate data in each tab’s fields. 

For example, on the Scheduling tab, the fields you will find include: 

 Work Center – enter the work center ID. 

 (Description) – enter the work center description. 

 Department – select a Department for the work center. 

 Backflush - select Labor, Machine, Both, or Neither to indicate whether labor and/or machine 
time is to be backflushed. 

 Control Point – select this check box to designate the work center as a control point for 
recording routing transactions. This setting becomes the default setting on routing operations 
associated with this work center. 

On the Resource Groups tab, available fields include: 

 Group – select a resource group to associate with this work center. 

 Quantity – enter the quantity of the selected resource group required for this work center. 

 Add additional resource groups as needed. 

Account numbers for the following work-in-progress (WIP) accounts are found on the Accounts tab: 

 Material WIP Acct 

 Labor WIP Acct 

 Fixed Ovhd WIP Acct 

 Variable Ovhd WIP Acct 

 Outside WIP Acct 

Account numbers for each of the following variance accounts are found on the Variance tab: 

 Material Usage Variance 

 Labor Rate Variance 

 Labor Usage Variance 

Account numbers for each of the following overhead accounts are found on the Ovhd Accts tab: 

 Fixed Matl Ovhd Usage 

 Var Matl Ovhd Usage 

 Fixed Labor Ovhd Usage 

 Var Labor Ovhd Usage 

 Fixed Mach Ovhd Usage 

 Var Mach Ovhd Usage 
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After completing all necessary information for the work center record, you should save the record. 
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Setting up a scrap account 

When you post pieces scrapped, the system will post the cost of that piece up to and including the 
operation where you posted scrap. Then it will move the expense into a PS Scrap Expense account. You 
set up the scrap account on the Product Codes form. 

To set up a scrap account you begin by opening the Product Codes form from the Master Explorer > 
Modules > Material > Inventory > Files folder. Then, select the product code to which you are adding a 
scrap account. Next, go to the Misc tab, select an account number for the scrap account from the PS 
Scrap Expense drop-down list, and then save the record. 

 

 

The product code for which you are specifying a scrap account should be the product 
code assigned to the component material items used to manufacture the finished product. 
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Setting up a floor stock location 

In a repetitive manufacturing environment, materials are often kept at the point of use, and, unless you 
have lot or serial number tracked items, you will backflush your materials. 

These point-of-use locations are called floor stock locations and are attached to the work center.  

A floor stock location is associated with a work center on the Locations form. The Floor Stock 
Replenishment Report uses only this relationship when it calculates what is needed to fill floor stock 
locations for production. 

To set up a floor stock location you begin by opening the Locations form. You would then add a new 
record, enter a location code for the new location, provide a description of the location, and select the 
work center to which this floor stock location is associated from the WC drop-down list. Finally, you should 
save the record. 

 

 

Demo: Set up work centers and floor stock location 

Your instructor will demonstrate how to set up work centers and a floor stock location for 
repetitive manufacturing. 

 

 

______________________________________________________________________ 
 
______________________________________________________________________ 
 
______________________________________________________________________ 
 
______________________________________________________________________ 
 

 

 

Exercise 2.1: Set up work centers and floor stock location 

In this exercise, you will set up work centers and a floor stock location for repetitive 
manufacturing. 

 

Progressive Cycles has decided to manufacture the handlebars for their bicycles that they had previously 
purchased. They will be built in a special cell dedicated to making both styles of handlebars, the upright 
and racing. The handlebar items are TA-30000 (upright) and TA-31000 (racing). 

The graphic below shows the cell that will manufacture them. There are three operations in this cell. 
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Forming 

 
 
 

Cutting 

  
 
 

Finishing 

 

 

 Aluminum Upright Racing 
 Tubing Handle Bar Handle Bar 

Exercise 2.1 steps 

Part 1: Create work center H-Cut and verify account number and Unit Code 2 combinations 

Find the PS-FIN work center record and copy it three times. Then, update the three copies to create the 
three new work centers shown below. 

 

Account Numbers are necessary for repetitive production transactions. For more 
information on costing, see the Costing Training Workbook. 

 Select Master Explorer > Modules > Production > Work Centers > Work Centers. The Work 
Centers (Filter In Place) form opens.  

 Click Filter In Place. 

 Select Line 24 (PS-FIN). Ensure the line is highlighted in blue. 

 Right-click Line 24 (PS-FIN). A drop-down list displays. 

 Select Copy. 

 Type H-CUT in the Work Center field to replace the existing text. 

 Type Cutting in the field to the right of the Work Center field (description) to replace the existing 
text. 

 Select 600 in the Department field, if it is not already selected. 

 Select Both in the Backflush field, if it is not already selected. 

 Select the Control Point check box. 

 Click the Costing tab. 

 Type 15 in the Setup Rate field, if the field does not already contain that value. 

 Type 15 in the Run Rate (Lbr) field, if the field does not already contain that value. 

 Click the Accounts tab. 

 Verify Account number and Unit Code 2 combinations for the accounts in the table below. 
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Account name Account number Unit code 2 

Material WIP Acct 12260 0009 

Labor WIP Acct 12262 0009 

Fix Ovhd WIP Acct 12264 0009 

Var Ovhd WIP Acct 12266 0009 

Outside WIP Acct 12268 0009 

 Click the Variance tab. 

 Verify Account number and Unit Code 2 combinations for the accounts in the table below. 

Account  name Account number Unit code 2 

Matl Usage Variance 51500 0009 

Labor Rate Variance 51600 0009 

Labor Usage Variance 51700 0009 

 Click the Ovhd Accts tab. 

 Verify Account number and Unit Code 2 combinations for the accounts in the table below. 

Account  name Account number Unit code 2 

Fix Matl Ovhd Usage 51830 0009 

Var Matl Ovhd Usage 51880 0009 

Fix Labor Ovhd Usage 51810 0009 

Var Labor Ovhd Usage 51860 0009 

Fix Mch Ovhd Usage 51820 0009 

Var Mch Ovhd Usage 51870 0009 

 Click the Resource Groups tab. 

 Select Cut-10-MRG from the Group drop-down list on the first line of the grid. 

 Click Save. 

 

Part 2: Copy PS-FIN work center and create H-FORM and H-FIN work centers 

1. Select Line 24 (PS-FIN), ensure the line is hi-lighted in blue. 

2. Select System > Edit > Copy Ensure the line is highlighted in blue. 

3. Right-click Line 24 (PS-FIN). A drop-down list displays. 

4. Select Copy. 

5. Type H-FORM in the Work Center field to replace the existing text. 

6. Type Forming in the field to the right of the Work Center field (description) to replace the existing 
text. 

7. Select 600 in the Department field, if it is not already selected. 
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8. Select Both in the Backflush field, if it is not already selected. 

9. Repeat steps 10 through 18. Then proceed with step 32. 

10. Click the Resource Groups tab. 

11. Select PS-FRM-LRG from the Group drop-down list on the first line of the grid. 

12. Click Save. 

13. Right-click. A drop-down list displays. 

14. Select Copy. 

15. Type H-FIN in the Work Center field to replace the existing text. 

16. Type Finishing in the field to the right of the Work Center field (description) to replace the existing 
text. 

17. Select 600 in the Department field, if it is not already selected. 

18. Select Both in the Backflush field, if it is not already selected. 

19. Select the Control Point check box. 

20. Click the Resource Groups tab. 

21. Select PS-FIN-LRG from the Group drop-down list on the first line of the grid. 

22. Click Save modified data and close form (OK). 

 

Part 3: Create a new location 

1. Select Master Explorer > Modules > Material > Inventory > Locations. The Locations form 
opens.  

2. Click Create new object in the current collection. 

3. Type H-CUT in the Location field. 

4. Type Floor Stock in the Description field. 

5. Select work center H-CUT from the WC drop-down list. 

6. Click Save modified data and close form (OK). 
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Setting up items for production 

On the Items form, you need to set the cost type to “Standard” for items to be produced using repetitive 
manufacturing. On the Planning tab, if planning is being used, you need to set the production type to 
“Prod Sched” or “Just-In-Time” for these items to control the type of plan that planning will create. If using 
production schedules, you can also set a default “Rate per Day” for production schedule releases. 

Item fields to modify 

Items manufactured with production schedules use the following settings: 

 Cost Type = "Standard" 

 Production Type = "Prod Sched" 

 Rate/Day = demonstrated number of items the cell can produce in a day 

Items form – General tab 

Cost Type 

Items that are being manufactured using production schedules and JIT must have a cost type of 
“Standard.” Select Standard from the Cost Type drop-down list for the production item. 

Items form – Planning tab 

Production Type 

When the item is set to standard costing, this field becomes active. Select “Prod Sched” from the 
Production Type drop-down list for the production item. 

Rate/Day 

The quantity normally manufactured per day for the production item is entered in the Rate/Day field. This 
quantity will be used as the default value for the Generate Production Schedule activity. 

 

Activate backflushing for materials used in production 

Next in our setup are the components that are used as materials on the bill of materials for production 
schedules and just-in-time transactions. These materials should be specified as backflushed unless they 
are lot-tracked or serial-tracked.  

Materials specified on the BOM’s of production schedule items usually have their Backflush check box set 
selected. If materials are lot or serial number tracked, you cannot backflush them. Lot tracked and serial 
tracked items would have to be issued using the Work Center Material Transactions form.  

On these items you can select the Backflush check box on the Controls tab and add a backflush location.  

Items form – Controls tab 

Backflush 

The Backflush check box is selected to specify that this item can be backflushed. This field may be 
selected only if the “On Hand Negative Flag” is selected on the Inventory Parameters form and the Lot 
and Serial Track check boxes are not selected on the Items form. 

Backflush Location 
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The location from which material should be relieved when backflushing occurs is selected from the 
Backflush Location drop-down list. This field may also be left blank. This field can only be updated if the 
Backflush check box is selected. 

The next lesson provides much more detail on backflushing and control points. 

 

 

_____________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 

 

 

Demo: Set up items for production 

Your instructor will demonstrate how to set up production and material items for repetitive 
manufacturing. 

 

 

______________________________________________________________________ 
 
______________________________________________________________________ 
 
______________________________________________________________________ 
 
______________________________________________________________________ 
 

 

 

Exercise 2.2: Set up items for production 

In this exercise, you will set up production and material items for repetitive manufacturing. 

 

Exercise instructions 

The handlebar cell manufactures two kinds of handlebars: upright and racing. They are made out of a 
single material: aluminum tubing. Progressive Cycles has already been purchasing these items, therefore 
an Items record exists for each of them. However, since we will now be manufacturing the handlebars it 
will be necessary to make some changes to each of these items. 
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Exercise 2.2 steps 

Part 1: Change item TA-30000 and TA-31000 to source Manufactured, product code FG-200, cost 
type Standard, set production schedule and clear the backflush 

 Select Master Explorer > Modules > Material > Inventory > Items. The Items (Filter In Place) 
form opens.  

2. Click Filter In Place. 

3. Select TA-30000-Handle-Bars,Upright from the list in the left pane. 

4. Select Manufactured from the Source drop-down list. 

5. Select FG-200 from the Product Code drop-down list. A dialog box opens with the message, 
“Product Code was PP and now is FG-200. Automatically update Accounts and Unit Codes on 
the Item Stockroom Locations form when this record is saved?” 

6. Click Yes. 

7. Select Standard from the Cost Type drop-down list. A dialog box opens with the message, “Cost 
Type was Actual and now is Standard. [Update Unit Cost] will be performed on Save.” 

8. Click OK. 

9. Select Standard from the Cost Method drop-down list. 

10. Click the Planning tab. 

11. Select Prod Sched from the Production Type drop-down list. 

12. Type 50 in the Rate/Day field. 

13. Click the Controls tab. 

14. Clear the Backflush check box. 

15. Click Save. 

16. Select item TA-31000-Handle-Bars,Upright from the list in the left pane. 

17. Repeat steps 4 through 11. Then proceed with step 18. 

18. Type 30 in the Rate/Day field. 

19. Click the Controls tab. 

20. Clear the Backflush check box. 

21. Click Save. 

 

Part 2: For ZAL-200 set backflush 

1. Select item ZAL-200-Aluminum,Tube,1/8",1"dia      (ACT-FIFO) from the list in the left pane. 

2. Click the Controls tab. 

3. Select the Backflush check box, if it is not already selected. 

4. Delete the value in the Backflush Location field. 

5. Click Save modified data and close form (OK). 
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Check your understanding 

 

What must the cost type be for an item that is produced under a production schedule? 

 

a) Actual 
b) Average 
c) Estimated 
d) Standard 

 

 

Where is a scrap account to be used in repetitive manufacturing specified? 

 

a) Chart of Accounts form 
b) Product Codes form for the product code assigned to a component material 
c) Product Codes form for the product code assigned to a production item 
d) Work Centers form for the work center where a component material is used 

 

 

At which level is costing in repetitive manufacturing maintained? 

 

a) Job 
b) Item  
c) Work Center 
d) Product code 
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Lesson 3: Backflushing and control 
points 

Estimated time 

50 minutes 

Learning objectives 

After completing this lesson, you will be able to: 

 Describe how control points and backflushing are used in production schedule processing. 

 Identify the steps to set up control points and backflushing for an item routing. 

Topics 
 Introduction 

 Control points 
o Setting up control points 
o Control point processing 
o What happens when a control point is posted? 

 Backflushing 
o About backflushing labor and machine hours 
o Backflushing labor hours 
o Backflushing machine hours 
o About backflushing materials 
o Hierarchy of backflush locations 
o Inventory parameters 
o Items form – Control tab 

 Backflushing materials 
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Introduction 

Backflushing is a way to minimize the number of transactions you have to create. 

Based upon the routing of an item, backflushing automatically issues materials or records machine and 
labor hours, or any combination of materials and hours. You can use backflushing in conjunction with 
control points, which further automates the process. 

Control points are used to manage the number of operations backflushed by a single transaction. 

In this lesson, you will learn how backflushing and control points are used in repetitive manufacturing, and 
how to set up for automatic backflushing when production transactions are entered. 
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Control points  

Use of control points can greatly reduce the number of manual entries needed to report production. 
Control points on operations serve two purposes:  

To define the operations on a routing from which production is reported 

To manage backflushing through multiple operations 

 

 

You can set each operation on a routing to be a control point and report production 
for each one, or you can set selected operations as control points and backflush the 
appropriate production quantities through the previous non-control point operations. 

When a work center is created, you must specify whether it is a control point or not. This setting will be 
the default value for the routing operation when a work center is associated with the operation. It is 
possible to overwrite the default for each operation of a routing. Any and all operations within a routing 
can be specified as a control point.  

The production schedule transactions can only be recorded at control points so the last operation in a 
routing should always be a control point for a repetitive item. Then a production schedule transaction can 
be posted that moves items into inventory.  

This last operation can be the only control point in a routing bill of material if you like which means that all 
of the other operations would automatically backflush once a production schedule transaction is posted 
against the last operation.  

You can set control points strategically throughout the routing and when posting a production schedule 
transaction at a control point, backflushing will take place and will flow back through the routing until it 
comes to a previous control point. 

Setting up control points 

On the Work Centers form, select the Control Point check box to designate this work center as a control 
point. If you are using the Backflushing feature, you can use control points to capture cost during 
production instead of waiting until production is complete. When using a work center for repetitive 
manufacturing, you can record production only at those work centers you have defined as control points. 

On the Operations form, select the Control Point check box to designate the operation as a control point. 
The setting of this check box defaults from the work center it is associated with. Clear the check box if the 
operation should not be a control point. 

Control point processing  

Backflushing is triggered automatically when you enter a quantity other than zero for quantity complete or 
scrapped for a posted transaction. If the operation is a control point, the system will look for preceding 
operations to verify whether they are control points or not. If not, then the system assumes that the 
preceding non-control point operations associated with that control point will also have the same quantity 
complete value backflushed.  

When you report a scrapped quantity for a control point, the same scrapped quantity is added to the 
quantity complete for all prior operations that are tied to that control point.  

For a production scheduled item, if scrap is reported on a non-control point operation, the quantity 
complete is updated for all previously associated non-control point operations and those operations will 
be backflushed.  
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For example, if you have this routing: 

Operation Control point? 

10 No 

20 Yes 

30 No 

40 No 

50 Yes 

When you post pieces complete at operation 20, the system will backflush operation 20. Then it will post 
the same quantity complete at operation 10, which in turn will trigger backflushing at that operation. 

When you post pieces complete at operation 50, the system will backflush operation 50. Then it will post 
the same quantity complete at operations 40 and 30, which in turn will trigger backflushing at those 
operations. 

What happens when a control point is posted? 

Based on how you have set up your Inventory Parameters form, Items form - Controls tab, Operations 
form, and Materials form for backflushing, when a control point is processed, the system will perform the 
following:  

 Manage the number of operations backflushed by a single transaction 

 Process each operation controlled by the control point in turn, starting with the lowest operation 
number 

 Backflush materials on the BOM for all operations controlled by the control point where the 
material has been set up to be backflushed 

 Backflush labor and/or machine hours for all control points for operations where the Backflush 
field is set to Labor, Machine, or Both 

 Absorb/backflush overhead for all operations controlled by the control point based on the setting 
for overhead basis in the work center 

 Move quantities to the next operation or to inventory (if it is the last operation), for all operations 
tied to the control point 

 Post or receive into inventory all quantities (received, complete, scrapped and moved), when 
appropriate 

 Apply scrap factors to the material issues 
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Backflushing 

Backflushing is the deduction from inventory records of the component parts used in an assembly or 
subassembly by exploding the bill of materials by the production count of assemblies produced. 

Backflushing enables you to record the manufacture of items without having to create job orders. This is 
particularly relevant in situations where the production runs are short and the benefits derived from 
creating a job order to track the activity on the shop floor do not justify the cost of processing all the data 
normally required for a job order. 

Backflushing is a streamlined process where the raw material is never issued to the shop floor or work in 
progress even though the material is physically moved from the warehouse to production. Instead, the 
system will continue to show the material still in raw material inventory. Then when the finished assembly 
is transferred to finished goods, the system automatically pulls all materials on the manufacturing bill of 
materials out of raw materials inventory and issues them to finished goods inventory. 

Backflush vs. traditional inventory flow 

If you are set up to backflush, you simply record pieces completed or scrapped at a routing operation, and 
the system will automatically create all the remaining material and operation transactions that would be 
necessary to complete or scrap that quantity. 

About backflushing labor and machine hours  

To backflush labor hours and machine hours, you must select the appropriate value on the Backflush 
check box on the Operations form. The default value displays from the work center used in the operation, 
but you can overwrite it for each operation for the current routing, job routing, and production schedule 
routing. You can specify backflushing of labor hours, machine hours, both, or neither, by operation.  

The system backflushes labor and machine hours based on 100% of the routing. The system does not 
consider manual entries of labor or machine hours for the current transaction. 

Backflushing labor hours  

When you post completed transactions, the system backflushes labor hours if the Backflush field for the 
operation is set to "Labor" or "Both."  

Backflushing occurs automatically when you post quantities for completed transactions or report scrap. 
The number of labor hours backflushed is based on the quantity complete or scrapped quantities 
multiplied by the labor hours per piece (defined on the routing). The system does not consider labor 
hours that have been previously backflushed or manually issued.  

For repetitive manufacturing, the system uses the production schedule BOM for backflushing labor. The 
system creates material transactions and inventory journal transactions with costs from the work center 
record. The system creates a production schedule transaction each time labor is backflushed. 

Note: For production schedules, if you specified Setup Hours on the PS item routing, the system creates 
a setup transaction for every PS release when any labor hours are backflushed. 

Backflushing machine hours  

When the Backflush field is set to "Machine" or "Both," the system backflushes the machine hours.  

Backflushing occurs automatically when you post quantities for completed transactions or report scrap. 
The number of machine hours backflushed is based on the quantity complete or scrapped quantities 
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multiplied by the machine hours per piece defined on the routing. For the current transaction, the system 
does not consider machine hours that have been previously backflushed or manually issued.  

For repetitive manufacturing, the system uses the production schedule BOM for backflushing machine 
hours.  

Material transactions and inventory journal transactions are created with costs from the work center 
record. The system creates a machine job transaction each time machine costs are backflushed.  

About backflushing materials 

You can designate multiple backflush locations for the same material. You specify the backflush location 
at the material level. With this method, you can manufacture one item on two production lines, each of 
which has different backflush locations specified. 

Hierarchy of backflush locations 

There are four levels of backflush locations. You do not have to use all four levels, but you must 
designate at least one backflush location if you plan to backflush the material. The system checks each 
level in a particular sequence; if the first level is blank, it moves on to the next level, and so on: 

1. The first level the system checks is the Backflush Location field on the Materials form. If the 
specified location does not exist for the item, the system creates the location record automatically 
and then backflushes from it.  

2. If the material's Backflush Location field is blank, the system searches for an item location that 
references the operation's work center. This is the second level that the system checks. 

3. If there is no location associated with the operation's work center, or the work center location 
does not exist for the item, at the third level the system checks the Backflush Location field on 
the Controls tab of the Items form.  

4. If the Backflush Location field on the Items form is blank, the system uses the Backflush 
Location specified on the Inventory Parameters form as the fourth level.  

At any point in this validation process, once you specify a backflush, the system uses that location from 
which to backflush, regardless of what locations might be set up at a higher level. For example, if the 
material/operation level has a specified backflush location, the system uses that location during 
backflushing, regardless of what you set up for the material at the item location/work center, Items - 
Controls, or Inventory Parameters levels. 

 

A backflush location cannot be a non-nettable location, nor can it be a transit type 
location. 

 

This example demonstrates the source of default backflush locations for a production schedule based on 
this setup: 

Form (part) Field settings 

Inventory Parameters form On Hand Neg Flag: Selected 

Backflush Location: Floor 

Items form - Controls tab 

(AL-10000) 

Backflush: Selected 

Backflush Location: Bin 

Item location/work center  Work center: AS-500 
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Floor stock location Floor stock location: A1 

Production Schedule Material form 

(AL-10000) 

Backflush: Selected 

Backflush Location: Z3 

A production schedule has operation 10 that goes through work center AS-500. That operation uses 
material AL-10000. The system checks the material level first and then backflushes from location Z3. If 
there is no backflush location at this level, the system proceeds to the next level and then backflushes 
from location A1 at the item location/work center level. 

If there were no item location/work center or floor stock level default, the system will check the Items – 
Controls form level for a backflush location (in this case Bin) and backflush from there. 

Finally, if no default location is specified at the Items - Controls tab level, the system will use the default 
value from the Inventory Parameters form and backflush from the default, "Floor" location. 

Inventory parameters  

To use backflushing, there are a couple of settings that must be made on the Inventory Parameters form. 
These parameters are: 

 On Hand Negative Flag 

 Backflush Location 

These inventory parameters are set on the Inventory Parameters form located in the Master Explorer > 
Modules > Codes > Parameters folder. Selecting the “On Hand Neg Flag” check box allows inventory 
transactions to take on-hand quantities below zero. Otherwise, inventory quantities will never be taken 
below zero which will prevent backflushing processes. A Backflush Location can also be selected on this 
form that identifies the default stock location from which all backflushed material will be withdrawn. 

After making changes to the form be sure to click Save on the toolbar. 

 

 

If you leave the backflush location at all four levels blank, you cannot perform 
backflushing. The system displays an error message when the “On Hand Neg Flag” check 
box is selected on the Inventory Parameters form and you did not indicate a backflush 
location. In this situation, you must specify a backflush location at some level in the 
hierarchy in order to backflush. 

 

Items form - Controls tab 

You can set up materials to be backflushed by selecting the Backflush check box on the Controls tab of 
the Items form. You can override this setting for each material on the BOM.  

An item can be set for backflushing by opening the Master Explorer > Modules > Material > Inventory > 
Items form, Controls tab for the specific item. Selecting the Backflush check box indicates that this item 
can be backflushed. This check box is activated only if the “On Hand Negative Flag” check box on the 
Inventory Parameters form is selected.  

A Backflush Location can also be selected from the drop-down list on this tab. This field is activated only 
when the Backflush check box is selected. You may also elect to leave this field blank.  

After making any changes to the form, be sure to save the record. 
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The backflush item and control point settings from the work center display default values 
from one of the operations forms (Current Operations, Production Schedule Item 
Operations, and Production Schedule Release Operations) that specify that work 
center. However, on the operations form, you can override the default values for the 
backflush item and backflush location. 

Backflushing materials 

You must establish a routing, comprised of operations, before you can attach materials to it. On the 
Operations form, you indicate what is backflushed - labor, machine, both, or neither. You can also specify 
whether the operation is a control point.  

On the Materials form, you can define whether an item is backflushed and a location from which to 
backflush it.  

 

If you will be using the Floor Stock Replenishment Report, it is better to leave the 
backflush location blank on the material level. Otherwise, you must set up the backflush 
location on the material level to be the same as the item location/work center level. 

 

The BOM and the location hierarchy, which you set up, control the materials to be backflushed and the 
backflushing location used for each material. See Hierarchy of backflush locations earlier in this lesson. 

 

When you post quantities for completed transactions or report scrap, backflushing occurs automatically. 
The quantity of the components backflushed is based on the quantity complete or scrapped quantities, 
multiplied by the quantity per piece defined on the BOM. Components that you have previously 
backflushed or manually issued are not considered for the current transaction. 

For repetitive manufacturing, the system uses the production schedule release BOM for backflushing 
materials.  

Use control points to manage the number of operations backflushed by a single transaction. 

The system creates material transactions and inventory journal transactions with appropriate costs based 
on the cost method used. The system creates a material issue transaction each time material is 
backflushed. 

 

 

Demo: Set up backflushing and control points 

Your instructor will demonstrate how the setup of backflushing and control points is done 
for repetitive manufacturing. 

 

 

______________________________________________________________________ 
 
______________________________________________________________________ 
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Demo steps 

 Select Master Explorer > Modules > Codes > Parameters > Inventory Parameters. The 
Inventory Parameters form opens. 

 View the settings for the On Hand Negative Flag check box and the Backflush Location field. 

(On Hand Negative Flag field is selected, Backflush Location field set to FLOOR) 

 Select Master Explorer > Modules > Material > Inventory > Items. The Items (Filter In Place) 
form opens. 

 Click Filter In Place. 

 Select item MB-10000-Bicycle,Model-180,Mountain,Black/White from the list in the left pane. 

 Click the Controls tab. 

 View the settings for the Backflush and Backflush Location fields.  

 

The Backflush check box is cleared and the Backflush Location field is empty. 

 Click Current Materials. The Current Materials (Linked) form opens. 

 Select each of the materials from the list in the left pane and view the settings for the Backflush 
and Backflush Location fields.  

 

The Backflush check box is selected for all materials and the Backflush Location 
field is empty for all materials. 

 Close the Current Materials (Linked) form. 

 Click Operations. The Current Operations (Linked) form opens. 

 Select each of the operations from the list in the left pane and view the settings for the Backflush 
field and the Control Point check box.  

 

The Backflush field is set to BOTH for all operations and the Control Point check 
box is selected only for operations 20 and 40. 

Note: The Backflush field is set to BOTH for all operations and the Control Point check box is 
selected only for operations 20 and 40. 

 Close the Current Operations (Linked) form. 

 Close the Items form. 

 Select Master Explorer > Modules > Production > Work Centers > Work Centers. The Work 
Centers (Filter In Place) form opens. 

 Click Filter In Place. 

 Select these work centers from the list in the left pane and view the settings for the Backflush 
field and the Control Point check box for each. 

a. PS-FIN (Backflush field = BOTH, Control Point check box = cleared) 

b. PS-HUB (Backflush field = BOTH, Control Point check box = cleared) 

c. PS-FRM (Backflush field = BOTH, Control Point check box = selected) 
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d. PS-HUB (Backflush field = BOTH, Control Point check box = cleared) 

e. PS-PKG (Backflush field = BOTH, Control Point check box = selected) 

18.  Close the Work Centers form. 
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Check your understanding 

 

List the four levels of backflush locations in the sequence that the system will check for a valid 
backflush location. 

 

_______________________________________________________________________ 
 
_______________________________________________________________________ 
 
_______________________________________________________________________ 
 
_______________________________________________________________________ 
 
_______________________________________________________________________ 
 
_______________________________________________________________________ 
 
_______________________________________________________________________ 
 
_______________________________________________________________________ 

 

 

Which of the following statements completes this sentence?  _____________ are used to 
manage the number of operations backflushed by a single transaction. 

 

a) Bill of material 
b) Work center resources 
c) Control points 
d) Inventory parameters 

 

 

Which of the following activities needs the On Hand Negative Flag setting activated on the 
Inventory Parameters form? 

 

a) Backflushing material 
b) Adding items to a production schedule 
c) Recording a production schedule complete transaction 
d) Processing a quantity adjustment 
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Lesson 4: Creating standard bills of 
materials (BOMs) for repetitive items 

Estimated time 

50 minutes 

Learning objectives 

After completing this lesson, you will be able to: 

 Describe the process to create a current BOM for a production item in repetitive manufacturing. 

 Determine the “Pieces per Hour” rate for a routing operation. 

 Identify the utilities and the sequence they are used to create a standard BOM. 

Topics 
 Introduction 

 Copying routings and BOMs 

 Creating a current BOM 
o Current operations  
o Adding materials to an operation 
o Setting up run durations for a cell or line 
o Determining the pieces per hour rate 
o Examples 

 Creating a standard BOM 
o Current Bill of Material Processor utility 
o Current BOM Cost Roll Up utility 
o Roll Current Cost to Standard Cost utility 
o  
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Introduction 

The use of production schedules requires accurate bills of materials (BOMs) to correctly record 
transactions when backflushing. Before using production schedules, the following BOMs are required: 

Production schedule BOMs 

Standard BOM 

Production schedule transactions post costs to the journal using a standard BOM, and post actual values, 
which are accumulated at the work center, using the production schedule BOM. 

 Production schedule BOMs can be created in the following ways: 

 Manually add each operation and material record 

 Copy from a variety of BOM types using the Copy Routing/BOM activity 

 Copy from current BOM type when you release a line 

A standard BOM is created by using the Roll Current Cost to Standard Cost utility. The current BOM for 
each of the production items must be accurate in order for the standard BOM to be accurate. 

In this lesson, you will learn how to copy a BOM, create a current BOM, and use various utilities to create 
a standard BOM. 
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Copying routings and BOMs 

You can freely copy back and forth between the current, job, estimate, and production schedule BOMs 
using the Copy Routing/BOM activity. You can also use the actual values from jobs versus those planned 
on a BOM. Once you copy a BOM, you can edit the new copy of the routing and bill of materials as 
necessary. 

 

BOM types – Arrows represent copy directions 

Copy Routing BOM form 

It is possible to have several routings and BOMs for the same item. You could have a routing and BOM 
for a current item, a production schedule, and a job that were each unique, but all for the same item. This 
allows for the flexibility to accommodate differences when manufacturing an item as a job or as a 
production schedule. 

 

To copy a routing/BOM, you first open the  Copy Routing BOM form. You then select or enter appropriate 
data in the fields on the form to specify the elements of a routing or BOM that you want to copy. Use the 
table below as a guide for the usage of the various fields. When you have finished selecting or entering 
data, click Process to complete the copy activity. 

 

 

Many of the fields on the form are grouped into sections: the “From” section on the left side 
of the form and the “To” section on the right side. This allows you to set a source and a 
destination or target for various elements in the copy activity. 
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Field Description 

From Category In this field you select the code to specify the source of the copy for the 
routing and the bill of materials (BOM). Options include: 

Job: to copy the setup and run hours shown on the Standards tab on the 
Job Operations form and the material quantities and material costs shown 
on the Materials tab on the Job Materials form. 

Current: to copy the item current routing and BOM from the Items form. 

Actual Job: to copy the actual, posted setup and run hours and actual 
material quantities and costs from the job. These values were posted 
through job transactions after the job was run and are shown on the Accum 
Values tab of the Job Operations and Job Materials forms. 

Estimate Job: to copy the routing and BOM from an estimate job. 

PS Item: to copy the routing and BOM from a production schedule item.  

PS Release: to copy the routing and BOM from a production schedule 
release. 

 

The category selected in this field determines which other fields on the 
form are available or required. 

To Category In this field you will select the code to specify the target of the copy for the 
routing and the bill of materials (BOM). Options include: 

Job: to copy the routing and BOM to a job. 

Current: to copy the routing and BOM to a target item’s current routing. 

Estimate Job: to copy the routing and BOM to an estimate job. 

PS Item: to copy the routing and BOM to a production schedule item. 

PS Release: to copy the routing and BOM to a production schedule 
release. The release you are copying to must exist, must have a status of 
Planned or Released, and must not have any posted production schedule 
transactions against it. 

When a job or production schedule has a status of Released, a message 
displays indicating that you are adding operations to a released job or 
production schedule. 

Job In the From section, the number of the job or estimate from which the 
information will be copied is typed or selected. 

 

In the To section, type or select the number of the job or estimate to which 
the information will be copied. 

 

Notes: 

If you leave this field blank, the next available job number will be used (this 
number will display at the conclusion of the copy process). 

 

If the job number in the To section has a released status, the existing 
routing and bill of materials cannot be modified. However, additional 
routings and bills of material can be added to the end of the existing 
routing.  
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Field Description 

Sched ID In the From section, you can type or select a valid production schedule ID 
from which the information will be copied.  

 

In the To section, you can type or select a valid production schedule ID, a 
new production schedule ID, or leave it blank and let the system create a 
new production schedule ID. 

Rework If the displayed job is a rework order, the Rework check box will be 
selected by default.  

 

Notes: 

If the target job (or estimate job) displayed in the To section is a rework 
order, you can copy a material to the job BOM that is the same as the job's 
end item. This recursive BOM structure is allowed only for rework jobs.  

You cannot copy a job structure to a new job if the job BOM contains a 
sub-job that is a rework order.  

You cannot copy materials from a rework order to a current BOM. 

Item In this field you can select the item from which to copy the current routing. 
It must be an inventoried item. 

Release In this field you can select the due date of the production schedule release 
from which to copy the routing/BOM information. 

Revision This field is where you would type the revision number of the item. 

Starting and Ending 
Operation 

You can specify the range of operations to copy. The default will be the 
starting and ending operation numbers from the job, production schedule, 
or current routing. These fields can be overwritten as needed. 

Copy UET Values To copy any existing User Extended Table (UET) values from the source 
routing/BOM, you can select this check box. 

Copy Indented BOM The default setting in this field is No. However if you select Yes, you are 
able to copy the BOM and create sub-jobs for any current subassembly 
materials within the BOM that have a Reference of Job. 

 

Note: When you first create the sub-jobs in this manner, the Start and End 
dates on those jobs will be blank. The next time you run APS Planning, the 
system will populate these dates based on the current plan data. If you are 
using MRP, you must run Scheduling to populate the blank dates on the 
sub-jobs. 

Extend by Scrap 
Factor 

The default setting is No. If you select Yes, the scrap factor displayed on 
the Current Materials form will be used as the variable for increasing the 
quantity on sub-jobs.  
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Field Description 

Option In this field you are able to select a destination for routings and BOMs 
being copied or you can accept the default of Insert Range.  

Delete All: Deletes the information specified. In the routing example, this 
option does not re-sequence the operation numbers. 

Insert Range: Inserts the information and re-sequences the operation 
numbers. For example, if you copy a routing with Operations 10, 20, 21, 
and 22 to a blank routing, the Insert Range option re-sequences the 
numbers to 10, 20, 30, and 40. 

Replace Range: Replaces existing information. In the routing example, 
this option does not re-sequence the operation numbers. 

On some forms, this field is disabled if the copy “TO” field is left blank. 

Labor, Material, or 
Both 

The default setting is Both. This field is used to further define what portion 
of a routing to copy. 

After Oper In this field you can specify the operation number after which to insert the 
new routing. 

Effective This field is where you can select a date to copy only non-expired BOMs or 
accept the default of the current system date. 

Copy to PS Release 
BOM 

Selecting this check box will copy the production schedule item's 
routing/BOM to any of the production schedule item's releases that do not 
have a routing/BOM.  

 

If the PS item does not contain a routing/BOM, the item’s current 
routing/BOM will be copied to the releases.  

 

This field is active only if you have selected PS Item in the To Category 
field. 

 

 

_____________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 
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Creating a current BOM 

As a reminder, the diagram below depicts the procedural steps for creating a BOM. 

 

Creating a BOM – procedural steps 

We will be focusing on steps 6 and 7 in this lesson. 

Current operations 

An operation specifies the times, resources required, and costs of a manufacturing process step. 

When creating or modifying current operations, you can use two forms: 

Engineering Workbench  

Current Operations form 

 

To create operations for an end item, open the Master Explorer > Modules > Material > Product Definition 
> Current Operations form and enter or select information as needed on the various tabs of the form.  

Use the Standards tab to maintain or view routing requirements for an item. Refer to the table below for 
the field descriptions for the Standards tab.  

Use the Resources tab to maintain the list of resource groups that can work on this operation. An 
operation must specify at least one resource group.  

Use the Costs tab to maintain cost rates of the operations. 

Note: In this course, we do not go into detail about all the scheduling, planning, and costing fields on the 
Current Operations form. 

 

Current Operations – Standards tab field descriptions 

Field Field Settings 

Fixed Schedule fields 

Use Fixed Schedule Selecting the Use Fixed Schedule field will allow you to set a fixed time 
for this operation regardless of lot size. Selecting this field will also 
update the Scheduler Rule on the resources tab. 

Fixed Sched Hours If the Use Fixed Schedule check box is selected, use this field to enter 
the expected total amount of time for the operation. When you use fixed 
hours, the Scheduler will ignore the values you have in the hours/piece 
and setup fields. The processing time for the operation will include: 

Step 1 
Create item 

records 

Step 2 
Create shift 

records 

Step 3 
Create resource 

records 

Step 5 
Create work center 

records 

Step 4 
Create resource 

groups 

Step 7 
Create material records 

for operations 

Step 6 
Create operations 

for end item 
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Field Field Settings 

Fixed Sched Hours 

Move hours 

Queue hours 

Finish hours 

Hours/Piece fields 

Machine Hours per 
Piece 

This field indicates the estimate of the hours of run time to produce one 
piece. If Sched Driver field = Machine, then enter a value in this field or 
in the Pieces per Machine Hour field. 

Pieces per Machine 
Hour 

This field represents the pieces that can be produced in a single 
machine hour. If Sched Driver field = Machine, then enter a value in this 
field or in the Machine Hours per Piece field. 

Labor Hours per Piece The value in this field is an estimate of the hours of cycle time to 
produce one piece. If Sched Driver field = Labor, then a value should be 
entered in this field or in the Pieces per Labor Hour field. 

Pieces per Labor Hour This field represents the pieces that can be produced in a single labor 
hour. If Sched Driver field = Labor, then a value should be entered in this 
field or in the Labor Hours per Piece field. 

Sched Driver This field will either have a value of Labor or Machine. 

Run Duration This field displays the processing time (adjusted for efficiency) for the 
operation that advanced planning and scheduling (APS) and the 
Scheduler will use to plan or schedule the resources for this operation. 
The system divides the Machine Hours Per Piece or Labor Hours Per 
Piece value by the number of resources from the Schedule Driver 
resource group type, and multiplies the value by (100 / Efficiency). 

Yield This field shows the percentage amount you expect to finish at this 
operation. An item’s shrink factor is linked to the yield amount. When the 
yield is changed for one or more operations for a given item, that item's 
shrink factor is recalculated. When the shrink factor is changed, the yield 
on the last operation on the item’s routing is updated. 

Hours fields 

Move The field displays the time of movement of work in progress (WIP) from 
the previous operation to this operation. 

Queue Time This field will display the estimated amount of time you expect the item 
to wait before being processed at this operation. 

Setup The field contains the time required to set up this operation. 

Finish The value of this field is the delay between completion of this operation 
and the start of the next operation in the routing. 

Use Offset Selecting this check box allows this operation to start before the 
previous operation completes. This allows overlapping operations, which 
is often used with assembly lines and cells. Note: This is not a setting 
for parallel processing. 
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Field Field Settings 

Offset Hours In this field you can enter the hours that will be used in the offset load 
splitting calculation. Various activities use offset hours as follows: 

APS. Offset is time-based. APS starts the operation the specified 
number of hours AFTER SETUP BEGINS on the previous operation. 
For example, one hour of offset means the planner begins the operation 
with an offset of one hour after setup starts on the previous operation. 

Scheduler. Offset is load-based. The Scheduler splits the load at the 
operation into smaller loads when setup finishes. When these smaller 
loads finish at the operation they move independently to the next 
operation. The size of these smaller loads depends on the offset hour 
size and the hours per piece or fixed time. 

Lead Time Processor. Offset is time to wait. Reduces total lead time by 
the offset hours. 

 

 

All times should be entered as hours in decimal format. For example, an expected setup 
time of 45 minutes (45/60) is entered as 0.75. 

 

 

_____________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 

 

Adding materials to an operation 

A material specifies the items required to perform a given operation.  

 

To add materials to an operation, you start by clicking the Materials button on the Current Operations 
form. This will open the Current Materials form. Refer to the descriptions in the table below for fields on 
the Materials tab. After entering data you should save the record. 

 

Current Materials form – Materials tab field descriptions 
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Field Description 

Material This is a required field where you select the material to be added to the operation 
from the drop-down list. This can be an inventoried or non-inventoried Item. The 
system will apply cost per unit for inventoried items. Non-inventoried items might be 
supply items that will not directly affect costing of the job. These charges could be 
captured in the overhead accounts. 

Quantity This field is where you enter the number of units of this material required per unit or 
lot to manufacture the item. 

Per Lot 
Quantity/Unit 

These radio buttons indicate if the quantity needed of the material is per unit or per 
lot. If per lot is selected, then the planner calculates one item to be used for the 
whole job regardless of the quantity of the parent item to be produced or the lot size 
on the parent item record. 

Scrap Factor The field shows the percentage of expected scrap incurred during manufacturing for 
the component material. This percentage should be expressed as a decimal, e.g. 
10% is entered as "0.1," not "10." When using a scrap factor the total quantity is 
calculated as: 

 Total Quantity = Quantity * (1 - Scrap Factor) 

Probable This field is the percentage of probability that this component will be used in the 
manufacturing of the product.  

This field is unavailable if the configuration flag is not selected. 

If the configuration flag for this item is selected, then the quantity will be calculated 
as: 

 Total Quantity = Quantity * Probable 

Deliberate over-planning and under-planning are allowed. 

Effective If there's a date in this field, the planner will ignore this operation or material previous 
to the effective date. The default of a blank date turns this feature off. This field will 
appear only on the Current Operations and Current Materials screens. 

Obsolete If there's a date in this field, the planner will ignore this operation or material after the 
date set. The default of a blank date turns this feature off. This field will appear only 
on the Current Operations and Current Materials screens. 

Backflush You can select this check box if the material is to be backflushed. This field defaults 
to what was selected on the Controls tab of the item record. 

Backflush 
Location 

This field can be updated only if the Backflush check box has been selected. If left 
blank, the system checks the hierarchy during the backflushing process to obtain a 
backflush location. At any point in the validation process that the system encounters 
a valid backflush location it will use that location and ignore any other values set at 
higher levels. The order in which the system validates a backflush location is: 

 Current/Job/Production Schedule Materials 

 Floor stock locations for item at the operations work center 

 Item Maintenance - Controls 

 Inventory Parameters. 

Alt Group This field is used when defining a group of alternate materials for an operation. See 
the Specifying alternate materials topic later in this lesson. 



 

58 Lesson 4: Creating standard bills of materials (BOMs) for repetitive items  
 © 2016 Infor Education 

Field Description 

Alt Group 
Rank 

This field identifies the priority rank for this alternate material within the alternate 
group of which it is a member.  

 

 

_____________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 

 
_____________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 

 
_____________________________________________________________________ 
 
_____________________________________________________________________ 

 
 
 

 

 

Demo: Create a current BOM 

Your instructor will demonstrate two ways to create a current BOM for production items in 
repetitive manufacturing. 

 

 

______________________________________________________________________ 
 
______________________________________________________________________ 
 
______________________________________________________________________ 
 
______________________________________________________________________ 
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Exercise 4.1: Create a current BOM 

In this exercise, you will manually create a current BOM for one production item, and copy 
a current BOM to the current BOM for the other production item. 

Exercise instructions 

Current BOMs to support the manufacturing of each of the two handlebar production items are required. 
Both handlebars will use the same aluminum tubing, item ZAL-200, and will have similar routings.  

Exercise 4.1 steps 

Part 1: Create a current operation record for item TA-30000 and add a current material record to 
operation 10 

1. Select Master Explorer > Modules > Material > Product Definition > Current Operations. The 
Current Operations (Filter In Place) form opens. 

2. Click Filter In Place. 

3. Click Create a new object in the current collection. 

4. Type TA-30000 in the Item field. 

5. Select H-CUT from the WC (work center) drop-down list.  

6. Type 0 in the Move (hours) field. 

7. Click Save. 

8. Click Create new object in the current collection. 

9. Select H-FORM from the WC (work center) drop-down list. 

10. Type 0 in the Move (hours) field. 

11. Clear the Control Point check box, if it is not already cleared. 

12. Click Save. 

13. Click Create new object in the current collection. 

14. Select H-FIN from the WC (work center) drop-down list. 

15. Type 0 in the Move (hours) field. 

16. Select the Control Point check box, if it is not already selected. 

17. Click Save. 

18. Select TA-30000 Operation 10 from the list in the left panel of the screen. 

19. Click the Materials button. The Current Materials (Linked) form opens (linked to operation 10 of 
item TA-30000). 

20. Select ZAL-200 from the Material drop-down list. 

 

The Backflush check box should be selected (default from the Items form). 

21. Type 2 in the Quantity field. 

22. Click Save. 
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23. Click the X on the tab of the Current Materials (Linked) form to close the form. 

 

Part 2: Copy the current BOM to item TA-31000 and update the material record for operation 10 of 
the BOM by increasing the quantity of the material ZAL-200 to 3 feet. 

 Select Master Explorer > Modules > Material > Product Definition > Activities > Copy 
Routing BOM. The Copy Routing BOM form opens. 

 Select Current from the From Category drop-down list, if it is not already selected. 

 Select TA-30000 from the From Item drop-down list. 

 Select Current from the To Category drop-down list. 

 Select TA-31000 from the To Item drop-down list. 

 Click Process. A dialog box opens with the message, “[Copy Routing BOM] was successful.” 

 Click OK. 

 Close the Copy Routing BOM form. 

 Make sure that the Current Operations form is the active form and click Refresh the current 
collection. 

The three operations for the TA-31000 that were copied should now be listed. 

 Select TA-31000 Operation 10 from the list in the left panel of the screen. 

 Click the Materials button. The Current Materials (Linked) form opens (linked to operation 10 of 
item TA-31000). 

 Type 3 in the Quantity field. 

 Click Save. 

 Close the Current Materials (Linked) form. 

 Close the Current Operations form. 

 

Part 3: Assign the item stockroom location 

 Select Master Explorer > Modules > Material > Inventory > Item Stockroom Locations. The 
Item Stockroom Locations form opens. 

 Select MAIN from the Warehouse drop-down list. 

 Type ZAL-200 in the Item field. 

 Click Filter In Place on the toolbar to filter the collection for the ZAL-200. 

 Click Create new object in the current collection. 

 Select H-CUT Floor Stock from the Location drop-down list. 

 Click Save modified data and close form (OK). 

 

 

_____________________________________________________________________ 
 
_____________________________________________________________________ 
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Setting up run durations for a cell or line 

A cell or production line is comprised of a number of workstations, material buffers, and material transport 
mechanisms that connect them. 

A cell can be set up in a number of ways – as separate operations requiring separate resource groups, as 
one operation requiring a set of resources, or a mix of both. 

Regardless of how the resources are configured, it is important to make sure that the run duration for an 
operation reflects the “rate per day” that is set on the Items form. 

The Run Duration field on the Current Operations form displays the processing time (adjusted for 
efficiency) for the operation that advanced planning and scheduling (APS) and the Scheduler will use to 
plan or schedule the resources for an operation.  

 

Calculation 

To calculate the run duration for an operation, the system divides the value of “Machine Hours per Piece” 
or “Labor Hours per Piece” by the number of resources from the schedule driver resource group type, and 
multiplies the value by (100 / Efficiency). 

 

Run Duration = (Hours per Piece) / (Total Quantity of Required Resources) X (100/Efficiency) 

In the formula … The scheduler uses … 

Hours Per Piece Hours per Piece value that matches the schedule driver – 
for example, if schedule driver = “Labor,” then “Labor 
Hours per Piece” is used. 

Total Quantity of Required Resources Quantity of  those resource groups with a resource type 
that matches the schedule driver – for example, if an 
operation is assigned two labor resource groups and one 
machine resource group, then if the schedule driver 
=”Labor,” the value used is two. 

Quantity in Load Uses the job quantity, or if the operation has a split size, it 
uses the split size quantities. 
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Examples 

Schedule 
rriver Hours per piece 

Total quantity of 
required resources 

Scheduled run time per 
piece 

Crew 10 labor hr/pc 1 crew 10 hrs/pc for this resource 

Crew 10 labor hr/pc 2 crew 5 hrs/pc for both resources 

Crew 
10 labor hr/pc 

5 machine hr/pc 

2 crew 

1 machine 
5 hrs/pc for both crew and the 
machine 

Machine 
10 labor hr/pc 

5 machine hr/pc 

2 crew 

1 machine 
5 hrs/pc for both crew and the 
machine 

 

 

You must think carefully about how you want the Scheduler to allocate your resources 
and determine if it's most appropriate to use the resource group Quantity field or the 
Split Size field. 

Let's use an example of four crew members at a work center. The table below shows the effect of using 
each field. 

If Labor 
Hours/Pc 
equals... And you set… 

Then the scheduled 
run time per piece 
is... 

And the scheduler will work 
on a load... 

4 
Resource Group Qty = 4 

Split size= 0 
1 hour 

Only when all four resources 
are available 

1 
Resource Group Qty = 1 

Split size >= 0 
1 hour 

When any one of the four 
resources is available 

Determining the pieces per hour rate 

When you set up the production items in an earlier exercise, you specified a manufacturing rate per day 
on the Items form.  

The Pieces per Hour and Resources Quantity fields on the operations form of the production item’s 
routing need to be adjusted so that production rate is represented in the Run Duration field. Perform the 
calculations below to determine these values. 

 

Pieces per Hour = (Rate per Day) / (Hours in Day) / (Resource Quantity for Operation) 

Rate per Hour = (Rate per Day)  / (Hours in Day)  

Rate per Resource Hour = (Rate per Hour) / Resource Quantity for Operation) 

 

The key is to remember that the Pieces per Hour field is not referring to the number of pieces the 
operation produces in an hour. It is referring to the number of pieces finished per resource hour. 

For example, if an operation runs 10 hours per day, that operation can produce 50 pieces per day. That 
means it produces 5 pieces per linear hour of time.  
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But if there are five resources working in parallel on that operation, then you actually incur 5 labor hours 
or 5 machine hours for those five pieces produced in a linear hour. The value in the Pieces per Hour field 
needs to show the number of pieces that are produced per resource hour. In this case, the operation 
produces one piece for every resource hour. 

If your line isn't perfectly balanced, you may just want to focus on the bottleneck operation and set the 
rate for all operations in a cell or line equal to the rate at the bottleneck. 

 

Here is an example of using a Microsoft® Excel spreadsheet to enter data and calculate pieces per hour 
for an operation. 

 

Microsoft® Excel spreadsheet used to determine pieces per hour rates 

Examples 

Here are a number of examples for setting these values for various situations. 

 

Example 1: Single resource at 10 per hour 

You can create a cell by simply designating a group of machines or operators or areas as a single 
resource. In this example you have one resource representing the cell (which could be made up of all the 
machines and crew members at a cell). 

Setting Value 

Item Rate/Day 160 

Number of operations One, operation 10 

Resource quantity required for operation 1 of 1 

On-shift hours for all resources each day 16 

 

Setting Value 

Pieces per hour for operation 10 

Run duration for operation 6 minutes 

 

Here are the values plugged into the formula. 
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Rate per Day 

Divided by: 

Hours in Day 

Divided by: 

Total Resources 

Running In Parallel 

Equals: 

Pieces per Hour 

160 16 1 10 

 

Example 2: Multiple resources processing serially at 10 per hour 

You can create a cell and track each work center separately. In this scenario, you have three resources 
representing the three parts of the cell that run serially.  

Setting Value 

Item Rate/Day 160 

Number of operations Three:10, 20, & 30 

Resource quantity required for operation 10 1 of 1 

Resource quantity required for operation 20 1 of 1 

Resource quantity required for operation 30 1 of 1 

On-shift hours for all resources each day 16 

 

Setting Value 

Pieces per hour for operation 10 

Run duration for operation 6 minutes 

 

Here are the values plugged into the formula. 

Rate per Day 

Divided by: 

Hours in Day 

Divided by: 

Total Resources 

Running In Parallel 

Equals: 

Pieces per Hour 

160 16 1 10 

 

In this case, when you run the first piece, it will take 18 minutes before you get a finished item, but after 
that you will be running at a rate of 10 pieces per hour or 160 per day. 
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Example 3: Multiple resources processing parallel at 10 per hour 

You can create a cell and track each work center separately. In this scenario, you have two resources 
that run parallel.  

Setting Value 

Item Rate/Day 160 

Number of operations One: 10 

Resource quantity required for operation 10 1 of 2 

On-shift hours for all resources each day 16 

Pieces per hour for each operation 5 

Run duration for each operation 12 minutes 

 

Here are the values plugged into the formula. 

Rate per Day 

Divided by: 

Hours in Day 

Divided by: 

Total Resources 

Running In Parallel 

Equals: 

Pieces per Hour 

160 16 2 5 

 

Example 4: Multiple resources processing serial and parallel at 10 per Hour  

You could also model this as two operations:  one to represent the rate you load a line or cell, the second 
to represent the line or cell itself. The first and second operations run serially. But the resources in 
operation 20 run parallel. You would have five resources at operation 20 in this example. 

Setting Value 

Item Rate/Day 160 

Number of operations Two: 10 and 20 

Resource quantity required for operation 10 1 of 1 

Resource quantity required for operation 20 1 of 5 

On-shift hours for all resources each day 16 

Pieces per hour for operation 10 10 

Run duration for operation 10 6 minutes 

Pieces per hour for operation 20 2 

Run duration for operation 20 30 minutes 

Here are the values plugged into the formula for operation 10: 
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Rate per Day 

Divided by: 

Hours in Day 

Divided by: 

Total Resources 

Running In Parallel 

Equals: 

Pieces per Hour 

160 16 1 10 

 

Here are the values plugged into the formula for operation 20: 

Rate per Day 

Divided by: 

Hours in Day 

Divided by: 

Total Resources 

Running In Parallel 

Equals: 

Pieces per Hour 

160 16 5 2 

In this case, you load the line at a rate of 10 pieces per hour, or 160 pieces per day. When you start the 
first piece, it takes the whole duration of the second operation before you finish, but after that you 
complete items at the rate of 160 pieces per day. 

 

 

_____________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 

 
_____________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 

 
______________________________________________________________________ 
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Creating a standard BOM 

You cannot add, delete, or update a standard BOM directly. You must copy the operations and materials 
from the current BOM. To create a standard BOM from an item’s current BOM, you must run the following 
utilities: 

Current Bill of Material Processor 

Current BOM Cost Roll Up 

Roll Current Cost to Standard Cost  

Current Bill of Material Processor utility 

The Current BOM Cost Roll Up utility uses item low level codes in its processing. During the period, you 
may have changed some aspect of your BOM that affects an items low level code. If you do not have the 
Low-Level On Line check box selected on the Inventory Parameters form, then you will need to run this 
utility to update an item's low level code.  

Current BOM Cost Roll Up utility 

During the period, you may have changed some aspect of your BOM that affects item cost. Use this utility 
to calculate the cost of the current BOM as it now is. This utility updates the costs for all current BOMs 
and the current costs for manufactured items. 

Roll Current Cost to Standard Cost utility 

Once the current operations and current materials are set up for the production items, you must use the 
Roll Current Cost to Standard Cost utility to complete a standard BOM for each of the production items in 
repetitive manufacturing.  

This utility will copy current costs to standard costs, post any transactions necessary to revalue inventory, 
and copy the current BOM to the standard BOM record. 

First, open the Roll Current Cost to Standard Cost form. Use the following fields to filter the BOMs that 
you want to copy. 

Starting and Ending Product Code 

Starting and Ending Item 

Source 

ABC Code 

Cost Method 

Material Type 

Then, click Preview to view a listing of the current BOMs that will be copied, and adjust field filters as 
needed. Finally, select the Post check box and click Print to complete the activity. 

 

 

Demo: Create a standard BOM 

Your instructor will demonstrate the process for creating a standard BOM from a current 
BOM. 
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______________________________________________________________________ 
 
______________________________________________________________________ 
 
______________________________________________________________________ 
 
______________________________________________________________________ 
 

 

 

Exercise 4.2: Create a standard BOM 

In this exercise, you will complete the processes needed to create standard BOMs for 
repetitive manufacturing production items. 

 

Exercise instructions: 

To complete the setup of the routings and bills of material for the two types of handlebars, we must roll 
the current routing and bill of material to the standard routing and bill of material for each of the 
production items.  

Exercise 4.2 steps 

Part 1: Run the Current Bill of Material Processor utility for items TA-30000 and TA-31000 

 Select Master Explorer > Modules > Material > Product Definition > Utilities > Current Bill of 
Material Processor. The Current Bill of Material Processor utility opens. 

 Click Process. A dialog box opens with the message, “[Current Bill of Material Processor] was 
successful.” 

 Click OK. 

 Close the Current Bill of Material Processor form. 

 Part 2: Run the Current BOM Cost Roll Up utility for items TA-30000 and TA-31000 

1. Select Master Explorer > Modules > Material > Product Definition > Utilities > Current BOM 
Cost Roll Up. The Current BOM Cost Roll Up utility opens. 

2. Select the List During Processing check box. 

3. Click Process. A dialog box opens with the message, “[Current BOM Cost Roll Up] was 
successful.” 

4. Click OK. 

5. Close the Current BOM Cost Roll Up form. 

 

Part 2:  Preview and then copy (commit) the current BOM to the standard BOM for both items, 
using the Roll Current Cost to Standard Cost utility 

1. Select Master Explorer > Modules > Material > Product Definition > Utilities > Roll Current 
Cost to Standard Cost. The Roll Current Cost to Standard Cost utility opens. 

2. Select TA-30000 from the Starting Item drop-down list. 
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3. Select TA-31000 from the Ending Item drop-down list. 

4. Click Preview. 

5. Review the report output in the Report Viewer. 

6. Close the Report Viewer form. 

7. Select the Post check box. 

8. Click Print. A dialog box opens with the message, “Report Submitted.” 

9. Click OK. 

10. Click the X on the tab of the Roll Current Cost to Standard Cost form to close the form. 

 

Part 3: Verify that TA-30000 and TA-31000 have costs in the Std Unit Cost 

1. Select Master Explorer > Modules > Material > Inventory > Item Costs. The Item Costs 
(Filter In Place) form opens. 

2. Type TA-3* in the Item field. 

3. Click Filter In Place. 

4. Click the Cost Maint tab. 

5. Verify that there are costs associated with item TA-30000 in the Std Unit Cost panel of the Cost 
Maint tab. 

6. Select item TA-31000 from the list in the left panel of the screen. 

7. Verify that there are costs associated with item TA-31000 in the Std Unit Cost panel of the Cost 
Maint tab. 

8. Close the Item Costs form. 

 

 

_____________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 
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Check your understanding 

 

The value of the Run Duration field on the Current Operations form should reflect which 
value on the Items form? 

 

a) Variable lead time 
b) Shrink factor 
c) Allocated to production 
d) Rate per day 

 

 

What does the value in the Pieces per Hour field on the Current Operations form refer to? 

 

a) Number of pieces the operation produces in an hour 
b) Number of pieces produced per resource hour 
c) Average number of pieces produced in an hour 
d) Maximum number of pieces produced per resource hour 

 

 

Which type of BOM can create a standard BOM? 

 

a) Current BOM 
b) Estimating BOM 
c) JOB BOM 
d) Production Schedule BOM 
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Lesson 5: Creating production 
schedules 

Estimated time 

1 hour 

Learning objectives 

After completing this lesson, you will be able to: 

 Order the steps to define a production schedule for repetitive manufacturing. 

 Identify the BOMs that are needed for production scheduling and describe the processes in which 
they are created. 

Topics 
 Overview 

 Creating a production schedule 
o Production schedule header 

 Shop Floor Control Parameters form 
o Production schedule items and releases 
o Generating a production schedule 

 Copying a production schedule 

 Creating a production schedule BOM 
o Copy BOM buttons 
o Changing status to released 

 Creating production schedule item BOMs 
o Production schedule item operations 
o Production schedule item materials 

 Creating production schedule release BOMs 
o Production schedule release operations 
o Production schedule release materials 
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Overview 

Production schedules are typically used when you manufacture the same item regularly — standard 
products — and do not need precise tracking of actual labor and material costs for every job. 

Rather than being required to report all activity to a specific job order, production schedules allow 
activities and their costs to be charged to work centers. Production schedules allow you to authorize and 
release production in a simplified manner. Production schedules are sometimes referred to as work order-
less production. 

A production schedule can contain any number of different items and each item can have multiple 
releases. There are number of ways to create a production schedule. For example, you can: 

Manually add a production schedule 

Generate a production schedule 

Copy from another production schedule 

Firm a planned order (using the Materials Planner Workbench) 

Once the production schedule is created, you can copy a bill of material routing, using the Copy to 
Production Schedule Item BOM to copy at the Production Schedule item level. You can also copy routing 
BOM at the production schedule release level. Once a complete or scrap production schedule transaction 
has been processed against a production schedule item, the production schedule routing may not be 
modified. 

 

 

_____________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 
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_____________________________________________________________________ 
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Creating a production schedule 

Production schedules are one means of delivering your manufactured items into finished goods inventory. 
Production schedules use a rate-based scheduling method. You can use master production schedule to 
set the build schedule for any given item or you can use normal demand orders and let the planning 
engine calculate and create planned orders for your build schedule. In either case you will firm the 
planned orders into a production schedule.  

There are three parts to a production schedule: 

Production schedule header 

Production schedule items 

Production schedule releases 

Use production schedules to record repetitive or flow-based manufacturing processes. 

 

Order of events 

You would take the following steps to track manufacturing through production schedules. To begin, you 
need to create a production schedule header and then enter the production schedule:  

Items 

Releases 

Routings and BOMs 

Transactions 

 

The system displays error or warning messages if you add an item flagged obsolete or 
slow-moving to a forecast, a planned order, or a master production schedule. 
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Production schedule header 

Use production schedules to track continuous production occurrences that use similar manufacturing 
processes. 

First, you create the header for a new production schedule. Open the Productions Schedules form, add a 
new record, and enter the appropriate data in the fields on the form. Refer to the table below for field 
descriptions.  

 

Production Schedules form – header fields 

Field Description 

Schedule ID In this field, you can enter a unique identifier composed of numbers, characters, 
or a combination.  

 

Alternatively, you can enter a global Schedule ID Prefix on the Shop Floor 
Control Parameters form. The system starts all generated production schedule 
IDs with this prefix, followed by a sequential number (maximum of ten characters 
for the combination). Simply leave this field blank to have the system create the 
new ID when you save the production schedule. 

Status In this field you can change the status code for this production schedule (PS) or 
accept the default “Planned” status. Valid statuses are: 

Planned - the default value for new production schedules. A Planned status is 
used to indicate that the PS has been entered for planning purposes at this time. 
When a PS is in Planned status, the Scheduler does not recognize it. 

Released - at least one PS release is now available for production. 

Complete - the PS has finished production for all production schedule releases. 
A production schedule's status may be changed to Complete by manually 
entering the status change in this field. Upon changing the status to Complete, 
any load detail records are deleted from the system. You can change a 
completed PS back to Released status in order to release it again to production 
for additional work. 

Description The purpose or the process of the production schedule can be described in this 
text field. The system does not validate this field. 

Look Ahead 
and Look 
Behind 

These numeric fields are used to express the number of days in the past and the 
number of days in the future from the current day that production can be 
recorded. These fields are helpful when you do not record production on a daily 
basis.  

 

If these fields are left blank, the system will use the values in the Shop Floor 
Control Parameters form 
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Shop Floor Control Parameters form 

A few default production schedule parameters can be set on the Shop Floor Control Parameters form. 

 

Shop Floor Control Parameters form – Prod Sched tab 

 

This form can be opened by selecting Master Explorer > Modules > Codes > Parameters > Shop Floor 
Control Parameters. Then select the Prod Sched tab to enter the parameters that affect production 
schedules. 

Schedule ID Prefix 

In this field enter the default production schedule ID prefix. You may change the value on the production 
schedule. 

PS Look Ahead  

Use this field in conjunction with the PS Look Behind field to specify the range of production schedule 
releases the system considers when posting transactions. The value is the number of working days to 
look ahead from the current date. 

PS Look Behind 

Use this field in conjunction with the PS Look Ahead field to specify the range of production schedule 
releases the system considers when posting transactions. The value is the number of working days to 
look behind from the current date. 

 

Example: If you set the PS Look Ahead to 0 and the PS Look Behind to 5, this will cause the system to 
look for production schedule releases that fall within the last 5 working days from the date on which you 
record transactions. 

 

 

_____________________________________________________________________ 
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76 Lesson 6: Production schedule processing  
 © 2016 Infor Education 

Production schedule items and releases 

Production schedule items are the finished-goods inventory items that the production schedule produces. 
They are added to a production schedule using the Production Schedule Items form. 

This form is also used to schedule and display releases for the selected production schedule item. This 
form can be opened in two ways.  

Select Master Explorer > Modules > Production > Production Schedules > Productions Schedule Items. 
Then, select the production schedule ID to which you are adding production items. 

 

Or you can open the form by clicking the Items/Releases button on the Production Schedules form. When 
you open the form this way, it will display the production schedule ID and the selected item from the 
Production Schedules form. 

 

 

An item must have a "Standard" cost type before you can add it to a production      
schedule. 

An item must have a standard BOM before you can change the status of an item line to 
"Released." 

 

Add an item to the Production Schedule Items form by selecting System > Actions > New and entering 
the appropriate data in the fields on the form. See the table below for descriptions of the form’s fields. 

 

 

A production schedule may contain multiple items. You cannot add items to a 
production schedule that has a status of Complete. 

Production Schedule Items form – header fields 

Field Description 

Schedule ID You will type or select the production schedule ID from the drop-down list to 
which you are adding items in this field. Leaving the field blank allows the system 
to assign an ID. 

Item A valid item number of a standard-costed inventory item is either typed in this 
field, or selected from its drop-down list. 

For Whse In this field, you can select the warehouse code for the finished goods inventory 
in this field. The default value comes from the Default Warehouse field listed on 
the Inventory Parameters form. 

Revision Any finished good item that is affected by an engineering change notice, is 
detailed with the appropriate revision information in this field. This information is 
used to report and track inventory that has specific production requirements. 

When you copy the current routing/BOM to a PS release, the current 
routing/BOM for this revision is used. 
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Field Description 

PS Item BOM 
Exists 

This display-only check box is selected automatically when the displayed 
production schedule item has a production schedule item routing/bill of material. 
If you have not copied the item current routing to the production schedule item, 
this check box will be cleared. 

Now you can add additional items to the production schedule or create production schedule releases 
against the new item. 

 

Production schedule releases 

A production schedule release is the quantity of a production item that you plan to produce on a specific 
date. You must create a release schedule for each production item on the production schedule. You can 
add a release manually or generate multiple releases at one time. 

In the Production Schedule Releases grid area of the Production Schedule Items form, add a new line 
and enter the appropriate data in the required fields:  

Due Date - Enter the date for which this production is being planned.  

Status - Enter the status or accept the default of Planned.  

Released - Enter the quantity to be produced for this particular production occurrence. 

 

Note: Descriptions for these fields and other fields in the grid can be found in the table below. 

 

Save the release and add more releases as needed. 

 

Production Schedule Items form – production schedule releases fields 

Field Description 

Due Date The expected date that the production schedule release is to be received into 
inventory is typed or entered in the Due Date field. 

Completed This field displays the total quantity of the item posted as complete for the 
production schedule release. It is updated as a result of entering production 
schedule complete transactions. 

Scrapped The total quantity posted as scrapped for the production schedule release 
displays in this field. It is updated as a result of entering production schedule 
scrap transactions. 

Remaining This field displays the total quantity of the item remaining to be produced for the 
production schedule release. This field is updated by the system and is equal to 
the released quantity less the completed quantity. 



 

78 Lesson 6: Production schedule processing  
 © 2016 Infor Education 

Field Description 

Status The status code for the production schedule release is selected in this field or 
accept the default “Planned” status. Valid statuses are: 

 Planned - the default value for new production schedule releases. A Planned 
status is used to indicate that the release has been entered for planning 
purposes at this time.  

 Released - the production schedule release is now available for production. 

 Complete – production has finished for the production schedule release. A 
production schedule's status may be changed to Complete by manually 
entering the status change in this field. Upon changing the status to Complete, 
any load detail records are deleted from the system. You can change a 
completed PS back to Released status in order to release it again to production 
for additional work. 

PS Item 
Release BOM 
Exists 

This display-only check box is selected automatically when the displayed 
production schedule release has a unique routing/bill of material. If you have not 
copied the item current routing or the production schedule item routing/BOM to 
the production schedule release, this check box will be cleared. 

Scheduled This check box is selected by the system if the production schedule item has 
been scheduled. It is cleared if the production schedule item has not been 
scheduled. 

Projected This read-only field displays the projected date that the planning or scheduling 
functions estimate that the production schedule release will be completed. 

Ready This read-only check box shows whether a demand has any component 
shortages in the APS plan. If there are no shortages, the field is selected. If 
shortages exist, the field is not selected. 

 

Note: When you update the status from Planned to Released, the system prompts you to copy a routing 
(if one does not exist). For a production schedule to have a Released status, it must have a routing. 

Generating a production schedule 

Use the Generate Production Schedules (Rate Based) form to create production schedule releases for 
existing production schedules. You can also create new production schedules using this form. 

The “Allocated to Production” values on all production schedule materials are updated when you generate 
production schedules with a status of Released. 

 

Use the Generate Production Schedules (Rate Based) form to mass-generate production schedule 
releases. You should then enter or select appropriate data in the fields on the form. Refer to the table 
below for field descriptions. Clicking the Process button starts the process.  

 

Generate Production Schedules (Rate Based) form – field descriptions 

Field Description 

Item A valid inventory item number is entered in this field. 

Quantity The total quantity of the item you want to release over a period of time should be 
entered in this field. 
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Field Description 

Rate/Day In this field, you can enter the number to be completed per day. The system 
determines the number of releases to be created for the production schedule 
based on the total release quantity and the Rate/Day. 

For example, if you specify a total quantity of 200 and a rate per day of 10, then 
the activity will generate 20 releases with a quantity of 10 each. 

This field defaults from the Items form but can be overwritten. 

Start Date The start date is entered in the field or accept the default of the current system 
date. This is the date scheduling starts. This field is only active when the “Type 
Forward” radio button is selected. 

End Date The end date is entered in this field. This is the date that production is scheduled 
to end. This field is only active when the “Type Backward” radio button is 
selected. 

Frequency The number of days to indicate how often you will generate a schedule or release 
for this production schedule should be entered in this field. This is specified in the 
number of manufacturing calendar days. For example, specify "1" for a release to 
be created every day. 

Schedule ID The next available production schedule ID displays in this field. Use that schedule 
ID to create a new production schedule with a production schedule item and its 
releases. 

You may also select an existing production schedule ID and add items/releases 
to that production schedule. 

Type The “Forward” radio button should be selected to have the system generate 
releases forward from the start date. 

 

The “Backward” radio button can be selected to have the system generate 
releases backward from the end date. 

Status The status of the production schedule is selected in this field. Valid statuses, 
upon creating a production schedule, are Planned and Released. The production 
schedule must have a released status before any transactions can take place. 

By specifying a Released status, the system will automatically create the item's 
production schedule routing and bill of material by copying from the current 
routing and bill of material. 

Copy to PS 
Item BOM 

Select this check box to copy the item’s current routing/bill of material to the 
production schedule item (if the PS item does not contain a routing/BOM) when 
you run the activity. 

Copy to PS 
Release BOM 

To copy the production schedule routing/BOM of the item to each of the new 
releases that the activity creates, select this check box. If the PS item does not 
contain a routing/BOM, the item’s current routing/BOM will be copied to the 
releases.  

This check box is active only if the status of the PS item is Planned. If the PS 
item status is set to Released, this check box is selected automatically and 
cannot be changed. 
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Copying a production schedule 

Use the Copy Production Schedules form to copy one production schedule to another. The system 
creates the new production schedule and its associated releases with a status of Planned. The released 
quantities on the new production schedule equal the released quantities on the original. The completed 
quantities on the new production schedule equal zero. 

 

To copy a production schedule, begin by opening the Copy Production Schedules form. Then you should 
enter or select appropriate data in the fields on the form. Refer to the table below for field descriptions. 
When finished, clicking the Process button completes the copy activity. 

 

Copy Production Schedules form – field descriptions 

Field Description 

From Schedule 
ID 

and  

To Schedule ID 

The production schedule IDs to copy from and to are typed or selected in these 
fields. 

 

If you want to create a new production schedule, you would type a new 
production schedule ID in the “To Schedule ID” field. 

Starting Item 

and 

Ending Item 

The range of items to copy are entered in these fields. Leave the fields blank to 
copy all items. 

Starting Date 

and  

Ending Date 

The range of dates on which release lines are to be created are entered in these 
fields. 

Increment 
Release Dates 
By 

The number of days that indicate how often, in days, the release dates should be 
generated in the copied production schedule should be typed in this field. This is 
specified in the number of manufacturing calendar days. For example, specify "1" 
for a release to be created every day. 

Schedule 
Release Status 

The status of the production schedule is selected in this field. Valid statuses, 
upon creating a production schedule, are Planned and Released. The production 
schedule must have a released status before any transactions can take place. 

Copy BOM Select "Yes" to copy the routing/BOM to the new production schedule. 

 

 

After you create a PS release routing/BOM, it remains independent of the 
corresponding PS item routing/BOM. Changes you make to the PS release 
routing/BOM are not automatically synchronized to the PS item routing/BOM (and vice 
versa). 

 

 

Demo: Create a production schedule 

Your instructor will demonstrate how to generate new production schedules. 
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______________________________________________________________________ 
 
______________________________________________________________________ 
 
______________________________________________________________________ 
 
______________________________________________________________________ 
 

 

 

Exercise 5.1: Create a production schedule 

In this exercise, you will generate new production schedules. 

 

Exercise instructions 

Now that all the preparation has been completed to prepare our production cell, Progressive Cycles can 
begin handlebars production starting next Monday. Both handlebars, upright and racing, will be made 
next week in this cell. List the dates for next week below: 

Monday           /          /            

Tuesday          /          /            

Wednesday          /          /            

Thursday          /          /            

Friday           /          /            

 

Exercise 5.1 steps 

Part 1: Generate a production schedule for item TA-30000 and the TA-31000 

1. Select Master Schedule > Modules > Production > Production Schedules > Activities > 
Generate Production Schedules (Rate Based). The Generate Production Schedules (Rate 
Based) form opens.  

2. Select the Planned radio button in the Status section. 

3. Select TA-30000 from the Item drop-down list. 

4. Type 250 in the Quantity field. 

5. Type 50 in the Rate/Day field, if the value is not already 50. 

6. Select the Backward radio button, if it is not already selected. 

7. Select the [date for Friday of next week] in the End Date field. 

8. Type 100 in the Schedule ID field. 

9. Clear the Copy to PS Item BOM check box. 

10. Clear the Copy to PS Release BOM check box. 
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11. Click Process. A dialog box opens with the message, “[Generate Production Schedules (Rate 
Based)] will be performed.” 

12. Click OK. A dialog box opens with the message, “Not one Job Operation exists for Production 
Schedule Item that has [Schedule ID:100] and [Item: TA-30000]. [Copy] will be performed from 
Current Operation to Job Operation.” 

13. Click OK. A dialog box opens with the message, “5 Production Schedule Releases(s) were 
processed.” 

14. Click OK. 

15. Select TA-31000 from the Item drop-down list. 

16. Click OK. 

17. Type 150 in the Quantity field. 

18. Type 30 in the Rate/Day field, if the value is not already 30. 

19. Click Process. 

20. Click OK. A dialog box opens with the message, “[Generate Production Schedules (Rate Based)] 
will be performed.” 

21. Click OK. A dialog box opens with the message, “Not one Job Operation exists for Production 
Schedule Item that has [Schedule ID: 100] and [Item: TA-31000]. [Copy] will be performed from 
Current Operation to Job Operation.” 

22. Click OK A dialog box opens with the message, “5 Production Schedule Releases(s) were 
processed.” 

23. Close the Generate Production Schedules (Rate Based) form. 

 

Part 2:  Release quantities for TA-30000 and TA-31000 

1. Select Master Explorer > Modules > Production > Production Schedules > Production 
Schedules. The Production Schedules (Filter In Place) form opens.  

2. Click Filter In Place. 

3. Select Production Schedule ID 100 from the list in the left panel.  

 

Both production schedule items that you just generated should be listed in the grid 
on the form. 

4. Click Items/Releases. The Production Schedule Items (Linked) form opens with item TA-
30000 displayed. 

5. Click the number in row 3 (Wednesday release) under the Released column of the Production 
Schedule Releases grid. 

6. Type 100 in the Released field in row 3 (Wednesday release) of the Production Schedule 
Releases grid. 

7. Click Save. 

8. Select the second item (TA-31000) in the production schedule items list in the left panel of the 
screen. Item TA-31000 now displays on the Production Schedule Items form. 

9. Click the number in row 3 (Wednesday release) under the Released column of the Production 
Schedule Releases grid. 
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10. Type 60 in the Released field in row 3 (Wednesday release) of the Production Schedule 
Releases grid. 

11. Click Save. 

12. Close the Production Schedule Items (Linked) form. The Production Schedules form should 
now be the active form. 

13. Click Save. 

 

 

_____________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 
 



 

84 Lesson 6: Production schedule processing  
 © 2016 Infor Education 

Creating a production schedule BOM 

A production schedule requires both a BOM for each item on the production schedule and a BOM for 
each release. 

The PS item BOM acts as a template for all of the release BOMs when you use the copy buttons on the 
Production Schedule Items form. 

You can create both types of BOMs by: 

Manually entering the BOM operations and materials 

Using the Copy Routing/BOM activity 

Clicking the Copy BOM buttons on the Production Schedule Items form 

Changing the Status field for any release to "Released." You can do this one-by-one or use the Change 
Production Schedule Release Status utility to change the status on a range of releases. 

Copy BOM buttons 

There are two copy BOM buttons on the Production Schedule Items form: 

Copy to PS Item BOM 

Copy to Release BOM 

 

Buttons on the Production Schedule Items form 

Copy To PS Item BOM button 

This button copies the item’s current routing and bill of material (BOM) to the displayed production 
schedule item. This action creates a new set of operations and materials that you can modify for this 
production schedule item. To modify the production schedule item routing/BOM after it is copied, use 
these buttons: 

PS Item Operations 

PS Item Materials 
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If this production schedule item already has a routing/BOM, clicking this button 
replaces that routing/BOM with the item’s current routing/BOM, overwriting any 
changes you have made. Before you click this button, note whether the PS Item BOM 
Exists check box is selected. 

If there are releases for this production schedule item that do not contain a routing/BOM, the system 
prompts you also to copy the item current routing/BOM to those releases. If you want to do this, click Yes. 
Or, if you want to make changes to the production schedule item routing/BOM before copying it to the 
releases, click No. 

Copy to Release BOM button 

This button copies the production schedule item’s routing/bill of material (if it exists) or the item’s current 
routing/bill of material to the production schedule release that is selected in the grid. To modify the 
production schedule release routing/BOM after it is copied, use these buttons: 

Release Operations 

Release Materials 

 

 

If the selected production schedule release already has a routing/BOM, clicking this 
button replaces that routing/BOM, overwriting any changes you have made. Before you 
click this button, note whether the PS Item Release BOM Exists check box (located in 
the grid) is selected or not. 

 

 

After you create a PS release routing/BOM, it remains independent of the 
corresponding PS item routing/BOM. Changes you make to the PS release 
routing/BOM are not automatically synchronized to the PS item routing/BOM (and vice 
versa). 

 

Changing status to released 

Releasing a line allows transactions to be posted against the production schedule. In order for 
transactions to be recorded, there must be a routing/BOM for the production schedule release. If a 
production schedule release does not have a BOM associated to it, the system prompts the user to copy 
a routing/bill of material from the current BOM when the status is changed to Released. 

 

To change the status to Released for a production schedule item release: 

On the Production Schedule Items form, make sure you are working with the production schedule item 
that contains the release you want to update. 

In the grid at the bottom of the form, select the appropriate release and select Released from the Status 
drop-down list. 

You will be prompted to confirm the status change and to copy the PS item routing/BOM (if one exists) or 
the item current routing/BOM to the PS release. 

 

Change Production Schedule Release Status utility 
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This utility changes the status of all production schedule releases within a specified range. 

 

To change the status of a range of production schedule releases, begin by opening the Change 
Production Schedule Release Status utility. Then you can select the old release status and the new 
release status in the appropriate fields. Valid status changes are: 

Planned to Released 

Released to Completed 

Completed to Released (to make this change, the status of the production schedule must be Released) 

 

If you want to copy the item current routing/bill of material to the production schedule item (if the PS item 
does not contain a routing/BOM) when you run the activity, select the “Copy to PS Item BOM” check box. 

To specify the range of production schedule releases for which the status will be changed, you can select 
or enter appropriate data in the fields on the form. Then process the activity by: 

Selecting the Preview radio button and clicking Process. 

You can view the releases that will be affected by the status change in the grid on the form. You can also 
view the BOMs that exist for each production schedule item/release. Modify fields as necessary to narrow 
or expand the range of production schedule releases that will be affected. 

Finally, you should select the Commit radio button and click Process to complete the activity. 

 

Change Production Schedule Release Status utility – grid listing releases that will be affected 
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Creating production schedule item BOMs 

In most cases, production schedule item BOMs will be created when you add production schedule items 
to the production schedule and you choose to copy the item BOM to the production schedule item BOM. 

Using the Copy To PS Item BOM button on the Production Schedule Items form, as described earlier in 
this lesson, also creates a production schedule item BOM. Also, the Copy Routing BOM form can be 
used to copy an item BOM to a production schedule item BOM. 

The PS Item BOM Exists check box will be selected if there a BOM exists for the production schedule 
item. If the check box is cleared, you must create a BOM for the production schedule item. 

Production schedule item operations 

If you want to create the routing operations for a production schedule item, or modify operations that were 
copied from the item BOM, you can do so by clicking the PS Item Operations button on the Production 
Schedule Items form. This displays the Production Schedule Item Operations form from which you can 
add or modify routing operations for the production schedule item. 

Production schedule item materials 

If you want to add, modify, or delete materials for routing operations of a production schedule item, you 
can do so by clicking the PS Item Materials button on the Production Schedule Items form. This displays 
the Production Schedule Item Materials form from which you can add or modify materials for the 
production schedule item. 

 

 

_____________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 

 
_____________________________________________________________________ 
 
_____________________________________________________________________ 
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Creating production schedule release BOMs 

After you create a production schedule release BOM, it remains independent of the corresponding 
production schedule item BOM; changes you make to the release BOM are not automatically 
synchronized to the production schedule item BOM (and vice versa). 

 

When you post pieces complete, the system uses the Production Schedule Release 
BOM, not the Production Schedule Item BOM. 

Keep in mind that before the status for a production schedule release can be changed to Released, a 
production schedule release BOM must exist for the release. 

The PS Item Release BOM Exists check box in the Production Schedule Releases grid will be checked 
if a BOM exists for the production schedule release. If this check box is cleared, you must create a 
release BOM before you can change the status to Released. 

Production schedule release operations 

If you want to create the routing operations for a production schedule release, or modify operations that 
were copied from the production item BOM, you can do so by clicking the Release Operations button on 
the Production Schedule Items form. This displays the Production Schedule Release Operations form 
from which you can add or modify routing operations for the production schedule item. 

Production schedule release materials 

If you want to add, modify, or delete materials for routing operations of a production schedule release, 
you can do so by clicking the Release Materials button on the Production Schedule Items form. This 
displays the Production Schedule Release Materials form from which you can add or modify materials for 
the production schedule release. 

 

 

_____________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 

 

 

Demo: Create and update the BOMs for a production schedule’s 
items and releases 

Your instructor will demonstrate how to create and update the BOMs for the items and 
releases of a production schedule. 
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______________________________________________________________________ 
 
______________________________________________________________________ 
 
______________________________________________________________________ 
 
______________________________________________________________________ 
 

 

Exercise 5.2: Create and update the BOMs for a production schedule’s 
items and releases 

In this exercise, you will create and update the BOMs for the items and releases of a 
production schedule. 

Note: Progressive Cycles has decided to change just the production schedule rather than the 
current routing and bill of materials. The reason they are doing this is that this is a one-time 
only startup change. Next time they will use the current routing and bill of material without any 
alterations. 

Select the first release of PS item TA-30000 and update the production schedule release BOM 
for this release only with the updated quantity of the material. 

For PS item TA-31000, use the Copy To PS Item BOM button to copy the current BOM to the 
PS item BOM. It should prompt you to copy that same BOM to all of the releases. If it doesn’t, 
use the Copy to Release BOM button to create the PS release BOMs. 

Finally, use the Change Production Schedule Release Status utility to change the status for 
all releases of both PS items to Released. 

Exercise 5.2 steps 

Part 1: For PS item TA-30000, use the Copy To PS Item BOM button to copy the current BOM to 
the PS item BOM. It should prompt you to copy that same BOM to all of the releases.  

 Select Master Explorer > Modules > Production > Production Schedules > Production 
Schedules. The Production Schedules (Filter In Place) form opens. 

 Click Filter In Place. 

 Select Production Schedule ID 100 from the list in the left panel. 

 Click Items/Releases. The Production Schedule Items form opens with item TA-30000 
displayed. 

 Click Copy to PS Item BOM. A dialog box opens with the message, “[Copy Routing/BOM] will be 
performed.” 

 Click OK. A dialog box opens with the message, “[Copy Routing/BOM to PS Releases without a 
Route/BOM] will be performed.” 

 Click OK. 

 

Part 2: Update the quantity for the ZAL-200 from 2 to 3 

1. Click the first row in the production schedule releases grid to select the first release. 

2. Click Release Materials. The Production Schedule Release Materials (Linked) form opens. 
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3. Type 3 in the Quantity field to replace the existing value. 

4. Click Save. 

5. Close the Production Schedule Release Materials (Linked) form. 

 

Part 3: For PS item TA-31000, use the Copy To PS Item BOM button to copy the current BOM to 
the PS item BOM. 

1. Select the TA-31000 production schedule item from the list in the left panel of the screen. 

2. Click Copy to PS Item BOM. A dialog box opens with the message, “[Copy Routing/BOM] will be 
performed.”  

3. Click OK. A dialog box opens with the message, “[Copy Routing/BOM to PS Releases without a 
Route/BOM] will be performed.” 

4. Click OK. 
 

 

The PS Item BOM Exists check boxes for all releases of both PS items should be 
selected, indicating that all of the necessary BOMs for the production schedule are 
in place. 

 

Part 4: Use the Change Production Schedule Release Status utility to change the status for all 
releases of both PS items to Released. 

1. Select Master Explorer > Modules > Production > Production Schedules > Utilities > 
Change Production Schedule Release Status to open the Change Production Schedule 
Release Status utility. 

2. Select Planned from the Old Status drop-down list, if it is not already selected. 

3. Select Released from the New Status drop-down list, if it is not already selected. 

4. Clear the Copy to PS Item BOM check box. 

5. Select 100 from the Start Schedule ID drop-down list. 

6. Click Process. A dialog box opens with the message, 10 Production Schedule Release(s) were 
processed.” 

7. Click OK. 

The grid on the bottom of the form will display the affected releases for your review. 

8. Select Commit. 

9. Click Process. A dialog box opens with the message, “[Change Production Schedule Release 
Status] will be performed.” 

10. Click OK. A dialog box opens with the message, “10 Production Schedule Release(s) were 
processed.” 

11. Click OK. 

12. Close the Change Production Schedule Release Status utility form. 

13. Close the Production Schedule Release Materials (Linked) form. 

24. Close the Production Schedules form. 
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Check your understanding 

 

List the various bills of material (BOMs) that must be in place before production schedule 
processing can take place.  

 

_______________________________________________________________________ 
 
_______________________________________________________________________ 
 
_______________________________________________________________________ 
 
_______________________________________________________________________ 
 
_______________________________________________________________________ 
 
_______________________________________________________________________ 
 
_______________________________________________________________________ 
 
_______________________________________________________________________ 

 

 

Which of the following conditions must be met for transactions to be posted against a 
production schedule release? Select all that apply. 

 

a) The status of the release must be Released 
b) .The release must be firmed into a job order.  
c) There must be a routing/BOM for the release.  
d) All of the operations in the release routing must be control points. 

 

 

True or false. Changes you make to the PS item routing/BOM are automatically 
synchronized to the PS releases routing/BOMs. 

 

a) True 
b) False 
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Lesson 6: Production schedule 
processing 

Estimated time 

40 minutes 

Learning objectives 

After completing this lesson, you will be able to: 

 Explain the process for replenishing floor stock locations. 

 Identify the transactions that are used for production schedule processing. 

 Describe the steps for recording completion of production schedule finished goods and scrap 
inventory. 

 Identify the reports that are generated to monitor production schedule finished goods. 

Topics 
 Introduction 

 Replenishing floor stock 
o Generating the Floor Stock Replenishment Report 

 Recording the finished goods 
o Production Schedule Complete Transactions form 

 Recording the production schedule scrapped inventory 
o Production Schedule Scrap Transactions form 

 Monitoring production schedule finished goods 
o Cumulative Production by Item Report 
o Production Schedule Report 
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Introduction 

Once the production schedules are created, you will need to have the following information for each cell 
or line to control production: 

 Schedule 

 Load 

 Daily dispatch 

 Required floor stock replenishments 

 Pieces completed 

The schedule, load, and dispatch can be created by APS or the Scheduler. See those training workbooks 
for more information. You can also use other tools described in the appendix to plan your production.  

In a repetitive manufacturing environment you record pieces completed and scrapped at a work center. 
The costs accumulate at the work center instead of to a job. You can also post time and material 
independent of pieces completed. The table below shows you which transactions to use. 

Using this transaction… You can post… 

Production Schedule Complete Pieces completed at a control point operation and a move to the 
next location or inventory. This will trigger backflushing of 
material, labor, and overhead. Lot or serial tracked materials 
cannot be backflushed. 

Production Schedule Scrap Pieces scrapped at any operation. This will trigger backflushing 
of material, labor, and overhead. 

Just-In-Time Production Pieces completed at last operation and a move into inventory. 
This will trigger backflushing of material, labor, and overhead. 

Work Center Material Material issued to a work center. Lot and serial tracked items can 
be issued with this transaction. 

Work Center Machine Time Machine time which triggers application of machine overhead. 

Work Center Labor Hours worked. 

In this lesson the production schedule transactions are covered, along with replenishing floor stock. The 
next lesson will cover the other transactions in the table above. 
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Replenishing floor stock 

The Floor Stock Replenishment Report is a tool that advises the user of quantities needed to fill floor 
stock locations attached to work centers to cover existing production requirements. 

This report does not issue stock. It provides consolidated quantities of items that are required to be 
moved to a floor stock location for pending production. 

This report works only for locations with work centers attached to them (a work center is designated on 
the Location Codes form). The location is referred to as a floor stock location (cannot be a transit or non-
nettable location). 

Generating the Floor Stock Replenishment Report 

Enter information and select options as needed and then click Preview to preview the output. Click Print 
to print the report.  

Warehouse 

Enter the warehouse for which you want to generate the report. 

Consolidate By 

To consolidate and sort the report by the From Location, you can select “From Location”. This format is 
best for people picking materials to replenish the floor stock locations. 

To consolidate and sort the report by the To Location, you should select “To Location.” This format is best 
for people replenishing materials for the floor stock locations. 

To print the report in both formats, you should select “Both.” 

Post Material Moves 

This option on the Floor Stock Replenishment Report posts a move transaction to move inventory to the 
appropriate location: 

 

Select All to move all available inventory. 

Select Filled Only to move only enough material to meet all requirements for the current run. 

Select None to move no inventory. 

Net WC/Floor Location Qty Avail 

To include or exclude the current quantity on hand at the work center floor stock location, you can select 
or clear this check box. Select this option if the quantity on the floor should be subtracted from the 
required quantity. 

Starting and Ending WC 

The starting and ending work centers to include on the report can be entered or selected. 

Starting and Ending Job 

The first and last job numbers you want to include on the report can be entered or selected. 
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Starting and Ending Schedule ID 

The first and the last production schedule IDs that you want to include on the report can be entered or 
selected. 

Starting and Ending Item 

The first and last item numbers to include on the report can be entered or selected. 

Starting and Ending Component Item 

The first and last component item to include on the report can be entered or selected. 

Starting and Ending Date 

The first and last date to include on the report can be entered. 

 

Floor Stock Replenishment Report – sample output 

 

 

Demo: Replenish floor stock 

Your instructor will demonstrate how to determine which floor stock locations need 
replenishment and how materials are moved to that location. 

 

 

______________________________________________________________________ 
 
______________________________________________________________________ 
 
______________________________________________________________________ 
 
______________________________________________________________________ 
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Exercise 6.1: Replenish floor stock 

In this exercise, you will determine which floor stock locations need replenishment and 
move materials to that location. 

The location H-CUT needs to be stocked with enough materials to support next week’s production. 

Exercise 6.1 steps 

Part 1: Process a miscellaneous receipt into the FLOOR stock location 

 Select Master Explorer > Modules > Material > Inventory > Activities > Miscellaneous 
Receipt. The Miscellaneous Receipt form opens. 

 Select ZAL-200 from the Item drop-down list. 

 Type 5000 in Quantity field. 

 Select FLOOR from the Location drop-down list. 

 Select MMR from the Reason drop-down list. 

 Click Receive. A dialog box opens with the message, “[Miscellaneous Receipt] was successful.” 

 Click OK. 

 Close the Miscellaneous Receipt form. 

 

Part 2: View quantities needed and move the materials to the H-CUT floor stock location 

 

Use the WC, Schedule ID, or Component Item ranges to limit the report to the cell we are 
using in this course. 

1. Select Master Explorer > Modules > Production > Work Centers > Reports > Floor Stock 
Replenishment Report to open the Floor Stock Replenishment Report form. 

2. Select MAIN from the Warehouse drop-down list. 

3. Select Both from the Consolidated By drop-down list. 

4. Select H-CUT from the Starting WC drop-down list. 

5. Select 100 from the Schedule ID drop-down list. 

6. Click Preview. 

7. View the report in the Report Viewer and view the amount of the ZAL-200 needed (1,190 ft.) 

8. Close the Report Viewer form. 

9. Select Filled Only from the Post Material Moves drop-down list. 

10. Click Print. A dialog box opens with the message, “[Post Material Moves] will be performed.” 

11. Click OK. A dialog box opens with the message, “Report Submitted” 

12. Click OK. 

13. Close the Floor Stock Replenishment Report form. 
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If desired, verify that the quantity of the material was moved by opening the Item 
Stockroom Locations form, filtering for the ZAL-200 item, selecting the H-CUT 
location for that item, and viewing the Location On Hand field value. 

 

 

_____________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 

 
_____________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 
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Recording the finished goods 

Use the Production Schedule Complete Transactions form to record the finished goods (pieces 
complete), and the Production Schedule Scrap Transactions form to record scrapped material. 

Processing production schedule complete transactions backflushes all labor, material, and machine time 
marked as backflush on the operations in the current routing bill of material. If you have lot-tracked or 
serial-tracked items that cannot be backflushed, you will need to enter work center material transactions 
for these items. Any differences between the standard routing and the current routing bill of material will 
be stored in the accumulated amounts tab of the work center and will create variances when running end 
of period costing. 

A production schedule release can only be consumed or have the completed/scrapped quantities applied 
against it, up to the released quantity, unless that production schedule release is the last production 
schedule release that falls within the current PS Look Ahead/Behind window. In that case, the remaining 
quantities will be posted against the last production schedule release, and the completed/scrapped 
quantity will exceed the released quantity. 

Production Schedule Complete Transactions form 

Use the Production Schedule Complete Transactions form to record transactions for finished goods. 

To record the transaction, the appropriate data needs to be entered in the required fields. The following is 
a snapshot of the different fields on the form. 

 

Item – The item ID of the finished production item is typed or selected in this field. 

Completed – The user types the completed quantity, excluding scrap, in the item's base unit of measure. 

Transaction Date – A date is entered for the transaction or the default date can be accepted. 

Schedule ID – The production schedule ID from which the item was produced can be entered in this field. 

Work Center – The work center corresponding to the operation for which completion is being recorded 
can be entered in this field.. 

Operation – The operation of the production schedule release for which completion is being recorded 
should be selected in this field. Only operations designated as control points can be selected. 

Employee – The employee number of the person reporting the completed quantities can be entered in 
this field. 

Shift – The shift ID of the shift when completion of the item was reported can be entered in this field.  

Location – A valid item location where finished goods will be moved to inventory can be entered in the 
field. If the operation is the last on the routing, then the default value is the first ranked item location. 

Lot - The lot number displays for items that are lot tracked and will default to the next valid lot number 
based on the item's lot prefix. 

 

When finished entering data, clicking Process will complete the transaction. 

 

 

Production schedule complete transactions apply only to operations designated as control 
points.  
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Posting process 

When a control point operation is posted, the system: 

Processes each operation controlled by the control point in turn, starting with the lowest operation 
number. 

Backflushes materials on the BOM for all operations controlled by the control point where the material has 
been set up to be backflushed. 

Backflushes labor and/or machine hours for all control points for operations where the Backflush field is 
set to Labor, Machine, or Both. 

Absorbs/backflushes overhead for all operations controlled by the control point based on the setting for 
overhead basis in the work center. 

Moves quantities to the next operation or to inventory (if it is the last operation), for all operations tied to 
the control point. 

Posts or receives into inventory all quantities (received, complete, scrapped and moved), when 
appropriate. 

Applies scrap factors to the material issues. 

 

Backflushing examples 

Backflushing example #1 

 

Operation Quantity 

 

Control Point 

Complete? Complete? 

10 5 No Yes 

20 5 No Yes 

30 5 Yes Yes 

40 0 No No 

50 0 Yes No 

Backflushing Example #1 illustrates backflushing as it works for production schedules. Operation 30 is 
designated as a control point. If you enter a transaction and post it for quantity complete of 5, then the 
system will assume that a quantity of 5 was also completed for operations 10 and 20. (This also assumes 
that this is the only transaction that has been posted against this job.) 

For production schedules, if you complete the operation which serves as a control point, the prior 
operations tied to the control point will be completed. From the example above, if you posted a complete 
transaction for operation 30, as indicated, operations 10 and 20 will have records created as a result that 
would complete them. 

The system does not assume that all operations or control points must have transactions entered and 
posted for them. The system does not require or validate that previous operations or control points have 
been posted. Using the same example, you can post operation 50 with a quantity complete of 5 and 
Complete, "Yes," without having posted operation 30, or any other previous operation. 
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The system will not prevent you from doing this. However, only operation 50 (and operation 40 that is tied 
to it), will backflush. The system will not go back and backflush operation 30 (and operations 10 and 20 
that are tied to it). This is depicted in Backflushing example #2 below. 

Backflushing example #2 

 

Operation Quantity 

 

Control Point 

Complete? Complete? 

10 0 No No 

20 0 No No 

30 0 Yes No 

40 5 No Yes 

50 5 Yes Yes 

 

 

_____________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 

 
_____________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 
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Recording the production schedule scrapped 
inventory 

Scrapped inventory must be recorded for production schedule releases. You can report scrapped 
quantities for any operation in a production schedule; the operation does not have to be a control point. 

So you can select any operation, a reason code, and employee and a shift to record a production 
schedule scrap transaction.  

Production schedule scrap transactions trigger backflushing of material, labor, and overhead just as the 
production schedule complete transactions did. 

Production Schedule Scrap Transactions form 

Use the Production Schedule Scrap Transactions form to record transactions for finished goods. 

To record the transaction, the appropriate data needs to be entered in the required fields. The following is 
a snapshot of the different fields on the form. 

 

Item – The item ID of the material being scrapped is typed or selected in this field. 

Scrapped – The user types the quantity of the material that is being scrapped in this field. 

Schedule ID – The production schedule ID from which the item was produced can be entered in this field. 

Reason – The reason code corresponding to the reason the material is being scrapped must be entered 
in this field. 

Employee – The employee number of the person reporting the scrapped quantities can be entered in this 
field. 

Work Center – The work center corresponding to the operation for which scrap is being recorded can be 
entered in this field. 

Operation – Any operation of the production schedule release for which completion is being recorded 
should be selected in this field.  

Transaction Date – A date is entered for the transaction or the default date can be accepted. 

Shift – The shift ID of the shift when the scrap was reported can be entered in this field.  

 

When finished entering data, clicking Process will complete the scrap transaction. 

 

 

You can execute production schedule scrap transactions from any operation and does not 
require that you have previously reported completed quantities. 
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Posting process 

When you report a scrapped quantity on the Production Schedule Scrap Transactions form, the system 
does the following: 

Stores backflushed costs as WIP for the reported operation and for operations after the prior control point 

 

Removes from WIP the total cost of the scrapped goods (determined by the PS routing) for that 
operation, along with the cost of all prior operations for each work center 

 

Note: The system does not remove setup costs or cost of materials issued by lot from WIP. 

 

Posts the accumulated WIP costs of the scrapped goods to the new scrap expense account 

 

When you run the “End of Period Costing” activity, the system deducts scrap expense from actual costs 
before determining the variance. The system determines the variance by comparing actual costs to 
earned costs. Reporting scrapped goods does not increase earned amounts. “End of Period Costing” is 
covered in the next lesson. 

 

 

_____________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 

 
_____________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 
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Monitoring production schedule finished goods 

You can view finished production by item or by schedule using the “Cumulative Production by Item 
Report” and the “Production Schedule Report.” 

Cumulative Production by Item Report 

The Cumulative Production by Item Report lists all quantities and cumulative quantities for a selected 
range of items, schedule IDs and dates. The report is sorted by item. Use this report to determine the 
production status of an item. 

 

This report shows the released, completed, and scrapped quantities of each item. It also includes 
cumulative released, completed, and scrapped quantities. You can specify the bin size to display; for 
example, weekly or monthly. 

 

Cumulative Production by Item Report – sample output 
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Production Schedule Report 

The Production Schedule Report displays a summary of production schedules, sorted by production 
schedule ID number. The report can be filtered by range of items, schedule IDs and dates. 

 

Production Schedule Report – sample output 

 

 

_____________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 

 
_____________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 
 

 

 

Demo: Record production schedule completed items and scrap 

Your instructor will demonstrate how to record production schedule completed items and 
scrap materials. 
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______________________________________________________________________ 
 
______________________________________________________________________ 
 
______________________________________________________________________ 
 
______________________________________________________________________ 
 

 

 

Exercise 6.2: Record production schedule completed items and scrap 

In this exercise, you will record production schedule completed items and scrap materials. 

 

Exercise instructions 

Let’s assume that production has started on the two handlebar items, TA-30000 and TA-31000, under 
production schedule ID 100 and that the first day of production on Monday has completed. Production 
transactions need to be recorded for the first release of both items. 

The following production forms were completed by the supervisor of the handle bar cell on Monday. 

 

Handlebar cutting work center (H-CUT) 

Part Completed Scrapped Reason Location 

TA-30000 52 3 Drop off --- 

TA-31000 28 2 Mfg. Process --- 

 

Handle Bar Finishing Work Center 

Part Completed Scrapped Reason Location 

TA-30000 51 1 Matl. Quantity INS-1 

TA-31000 27 1 Drop off INS-1 

Also, take a look at the location on-hand quantity for the aluminum tubing, item ZAL-200, using the Item 
Stockroom Locations form for stock location H-CUT. It should be 255 feet less than before the recorded 
production, indicating that backflushing was performed. 

Exercise 6.1 steps 

Part 1: Complete the production schedule transactions for TA-30000 for the completed items 

 Select Master Explorer > Modules > Production > Production Schedules > Activities > 
Production Schedule Complete Transactions.  The Production Schedule Complete 
Transactions form opens. 

 Select TA-30000 from the Item drop-down list. 

 Type 52 in the Completed field. 
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 Type [the next scheduled due date] in the Transaction Date field. 

 Type 100 in the Schedule ID field. 

 Select H-CUT from the Work Center drop-down list. 

 Select 10 from the Operation drop-down list, if it is not already selected. 

 Click Process. A dialog box opens with the message, “[Post] was successful.” 

 Click OK. 

 Select TA-30000 from the Item drop-down list. 

 Type 51 in the Completed field. 

 Type [the next scheduled due date] in the Transaction Date field. 

 Type 100 in the Schedule ID field. 

 Select H-FIN from the Work Center drop-down list. 

 Select 30 from the Operation drop-down list, if it is not already selected. 

 Select INS-1 from the Location drop-down list. 

 Click Process. A dialog box opens with the message, “[Post] was successful.” 

 Click OK. 

 

Part 2: Complete the production schedule transactions for TA-31000 for the completed items 

1. Select TA-31000 from the Item drop-down list. 

2. Type 28 in the Completed field. 

3. Type [the next scheduled due date] in the Transaction Date field. 

4. Type 100 in the Schedule ID field. 

5. Select H-CUT from the Work Center drop-down list. 

6. Select 10 from the Operation drop-down list, if it is not already selected. 

7. Click Process. A dialog box opens with the message, “[Post] was successful.” 

8. Click OK. 

9. Select TA-31000 from the Item drop-down list. 

10. Type 27 in the Completed field. 

11. Type [the next scheduled due date] in the Transaction Date field. 

12. Type 100 in the Schedule ID field. 

13. Select H-FIN from the Work Center drop-down list. 

14. Select 30 from the Operation drop-down list, if it is not already selected. 

15. Select INS-1 from the Location drop-down list. 

16. Click Process. A dialog box opens with the message, “[Post] was successful.” 

17. Click OK. 

18. Close the Production Schedule Complete Transactions form. 
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Part 3: Perform a Production Schedule Scrap transaction 

1. Select Master Explorer > Modules > Production > Production Schedules > Activities > 
Production Schedule Scrap Transactions.  The Production Schedule Scrap Transactions 
form opens. 

2. Select TA-30000 from the Item drop-down list. 

3. Type 1 in the Scrapped field. 

4. Type 100 in the Schedule ID field. 

5. Select LDD from the Reason drop-down list. 

6. Type 1 in the Employee field. 

7. Select H-CUT from the Work Center drop-down list. 

8. Select 10 from the Operation drop-down list, if it is not already selected. 

9. Type [the next scheduled due date] in the Transaction Date field. 

10. Click Process. A dialog box opens with the message, “[Post] was successful.” 

11. Click OK. 

12. Select TA-31000 from the Item drop-down list. 

13. Type 2 in the Scrapped field. 

14. Type 100 in the Schedule ID field. 

15. Select IMP from the Reason drop-down list. 

16. Type 1 in the Employee field. 

17. Select H-CUT from the Work Center drop-down list. 

18. Select 10 from the Operation drop-down list, if it is not already selected. 

19. Type [the next scheduled due date] in the Transaction Date field. 

20. Type 1 in the Shift field. 

21. Click Process. A dialog box opens with the message, “[Post] was successful.” 

22. Click OK. 

23. Close the Production Schedule Scrap Transactions form. 

 

Part 4: Verify the completed and the scrapped quantities 

1. Select Master Explorer > Modules > Production > Production Schedules > Productions 
Schedules.The Production Schedules (Filter In Place) form opens.  

2. Click Filter In Place. 

3. Select Production Schedule ID 100 from the list in the left panel. 

4. Click Items/Releases.  

5. The Production Schedule Items (Linked) form opens with item TA-30000 displayed. 

6. Verify the Completed and the Scrapped quantities in the grid for the first release. 

7. Select item TA-31000 from the listing in the left panel of the screen. 

8. Verify the Completed and the Scrapped quantities in the grid for the first release. 
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9. Close the Production Schedule Items (Linked) form. 

10. Close the Production Schedules form. 

 

Part 5: Verify the quantity on hand in the H-CUT location 

1. Select Master Explorer > Modules > Material > Inventory > Item Stockroom Locations. The 
Item Stockroom Locations (Filter In Place) form opens.  

2. Type H-CUT in the Location field. 

3. Click Filter In Place on the toolbar to filter for the H-CUT location. 

4. Verify the quantity in the Location On Hand field is 255 feet less than previous quantity (1190, 
935). 

5. Close the Item Stockroom Locations form. 

 

 

_____________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 
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Check your understanding 

 

Describe the maximum number of completed production items that can be recorded for a 
production schedule release and what happens when that maximum number is exceeded. 

 

__________________________________________________________________ 
 
_______________________________________________________________________ 
 
_______________________________________________________________________ 
 
_______________________________________________________________________ 
 
_______________________________________________________________________ 
 
_______________________________________________________________________ 
 
_______________________________________________________________________ 
 
_______________________________________________________________________ 

 

 

True or false. Production schedule scrap materials can only be recorded for a control point 
operation. 

 

a) True 
b) False 
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Lesson 7: Other transactions 

Estimated time 

40 minutes 

Learning objectives 

After completing this lesson, you will be able to: 

 Determine when work center transactions should be used. 

 Explain how just-in-time transactions are recorded. 

 Explain how work center transactions are recorded. 

Topics 
 Introduction 

 Posting  just-in-time (JIT) production transactions 

 Posting work center transactions 
o Work center labor transactions 
o Work center machine time transactions 
o Work center material transactions 

 End-of-period costing 
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Introduction 

With repetitive manufacturing most labor, material, and machine time transactions will be backflushed. 
However, sometimes backflushing is not convenient or even possible. For example, you cannot backflush 
lot or serial number tracked items. Or perhaps you needed additional labor or material to complete 
production for a few releases. 

 

While it is desirable to use the system to control repetitive manufacturing production through production 
scheduling, some production methods, such as KANBAN, only report finished goods being moved into 
inventory. In those cases, just-in-time (JIT) production transactions are used, instead of production 
schedule transactions, to record the move to inventory and the costs. 

 

In this lesson, you will learn about these other production transactions: 

Just-in-time (JIT) production 

Work center labor 

Work center machine hours 

Work center material 

 

The lesson will finish up describing the use of the end-of-period costing activity to reconcile production 
costs at the work center level. 

 

 

_____________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 
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Posting just-in-time (JIT) production transactions 

Just-in-time production transactions allow for the recording of transactions for items that are not tied to 
specific job orders or production schedules. You do not record any processes along the routing – only 
when the item is completely finished. Items being produced from just-in-time transactions must be 
standard costed.  

All backflushing will be done from the current routing. Just-in-time production transactions, job, and 
production schedules can be used simultaneously in the system. 

Just-in-time (JIT) production is typically used for the production of items that have a standard cost and 
that you want to be able to produce on demand. It is based on the idea of producing items that are not 
tied to specific job orders or production schedules, and transactions are only recorded when the item is 
actually finished. Use the Just-In-Time Production Transactions form to enter such items into inventory.  

To enter JIT production items into inventory 

Use the Just-In-Time Production Transactions form to record transactions for finished goods. 

To record the transaction, the appropriate data needs to be entered on the form. The following is a 
snapshot of the different fields on the form. 
 

Item – The item ID of the finished production item is typed or selected in this field. 

Completed – The user types the completed quantity, excluding scrap, in the item's base unit of measure. 
 

Note: This value cannot be zero. To enter items into inventory, use positive values. To remove items from 
inventory, use negative values.  

 

Warehouse – The warehouse where the finished goods are to be stored is entered here. 

 

Note:  If you try to select a warehouse with which the item does not already have an association, the 
system prompts you to create the association before you can select the warehouse. To create an 
item/warehouse association, use the Item/Warehouse form.  

 

Location – The location within the selected warehouse where you want the items stored is entered in this 
field. 

 

Note:  If you try to enter a location for which the warehouse does not have an association with the item, 
the system prompts you to let you know that it will automatically create the association. Click OK.  

 

Lot - The lot number displays for items that are lot tracked and will default to the next valid lot number 
based on the item's lot prefix. You may select the default number or enter a different number. 

 

Note: If you try to enter a lot identifier that does not currently exist, the system prompts you, to let you 
know that it will automatically create the lot. 
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Shift and Employee – optionally enter the shift in which the transaction is being performed and the 
employee performing it. 

If the item is a serial-tracked item, use the Serial Numbers tab fields to generate the serial numbers. 

When finished entering data, clicking Process will complete the transaction. 
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Posting work center transactions 

With repetitive manufacturing most labor, material, and machine time transactions will be backflushed. 
However, there are times when you need to issue additional labor or machine time, or material 
transactions directly to the work center. 

Work center labor, material, and machine time transactions are accumulated in the WIP bucket on the 
Accumulated Amounts tab of the work center. 

Work center labor transactions 

The Work Center Labor Transactions form is used to record labor directly to a work center, independent 
of an item or a production schedule. Appropriate data should be entered in the required fields: 

Work Center – The work center for which a labor transaction is being recorded is entered in this field. 

Employee – The employee number of the person whose labor is being recorded should be entered here. 

Start Time and End Time –The starting and ending times of the labor being recorded are optionally 
entered in these fields. 

Total Hours – The total labor hours being recorded for this transaction should be entered in this field. 

Shift – The shift ID of the shift when the labor being recorded was performed is entered in this field.  

Transaction Date – A date for the transaction is entered in this field, or accept the default of the current 
date. 

 

When finished, clicking Process will complete the transaction. 

 

Work center machine time transactions 

The Work Center Machine Time Transactions form is used to record machine time directly to a work 
center, independent of an item or a production schedule. Appropriate data should be entered in the 
required fields: 

Work Center – The work center for which a machine time transaction is being recorded is entered in this 
field. 

Total Hours – The total machine hours being recorded for this transaction should be entered in this field. 

Start Time and End Time – The starting and ending times of the machine time being recorded are 
optionally entered in these fields. 

Shift – The shift ID of the shift when the machine time being recorded was utilized is entered in this field..  

Transaction Date – A date for the transaction is entered in this field, or accept the default of the current 
date. 

Employee – The employee number of the person who reported the machine usage can be entered in this 
field. 

 

When finished, clicking Process will complete the transaction. 
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Work center material transactions 

The Work Center Material Transactions form is used to issue materials directly to a work center. If a 
production schedule or JIT item requires lot or serial tracked materials which cannot be backflushed, 
those materials must be issued using the Work Center Material Transactions form.  

Appropriate data should be entered in the required fields: 

WC – The work center to which the material will be issued should be entered in this field. 

Item – The item ID of the material being issued must be entered in this field. 

By Container and Container – The By Container check box can be selected and a container ID entered, 
if issuing by a container. 

Quantity – The quantity and unit of measure of the item being issued is entered in this field. 

Location – The warehouse location from which the material will be issued is entered in this field. 

Lot - The lot number from which the material will be issued can be entered in this field. 

Transaction Date – A date for the transaction must be entered in this field or accept the default of the 
current date. 

Employee – The employee number of a person associated with the material issue can be entered in this 
field, if desired. 

Account – The G/L account number to be credited is entered in this field. This is only required for items 
for which there are no item records in the system. 

Cost fields – The various costs of the non-inventory item being issued can be entered in these fields. 
This is only required for items for which there are no item records in the system. 

 

When finished, clicking Process will complete the transaction. 

 

Note: Use the Serial Numbers tab when you issue a serial-tracked item. 

 

Posting process 

During entry and posting of work center transactions: 

The system posts manual transactions when you enter them; there is no batch processing. In contrast, 
you must perform an additional step to post unposted job transactions after entering them.  

The system adds WIP costs to their respective WIP buckets on the Work Centers form, Accum Amt tab, 
when you enter the transaction.  

Each work center has associated WIP costs. When you move finished goods into inventory, the system 
computes the earned costs from each work center on the routing.  

When backflushing, JIT production ignores control points. The system processes all operations, and 
backflushing occurs where appropriate.  

When you enter transactions, variance accounts are not immediately updated. The system does not 
record variances until you run the End of Period Costing activity. 

 

 



 

116 Course summary  
 © 2016 Infor Education 

 

Demo: Record JIT production and work center transactions 

Your instructor will demonstrate how to create some work center transactions. 

 

 

______________________________________________________________________ 
 
______________________________________________________________________ 
 
______________________________________________________________________ 
 
______________________________________________________________________ 
 

 

 

Exercise 7.1: Record JIT production and work center transactions 

In this exercise, you will create some work center transactions 

Exercise instructions 

On Monday, the handlebar cutting work center had to stop production for 2 hours when the cutting 
machine broke down and maintenance had to be called in to fix it.  

Progressive Cycles wants to capture the cost of the maintenance worker plus the idle time associated 
with the other crew members while they waited for the machine to be fixed. 

 

Record the following hours at the H-CUT work center: 

Employee  Hours 

Michael Epstein 2 hours (Maintenance Worker)  

Robert Penrod 2 hours 

Jeff Smith  2 hours 

Thomas Zimmerman 2 hours 

Exercise 7.1 steps 

 Select Master Explorer > Modules > Production > Work Centers > Activities > Work Center 
Labor Transactions. The Work Center Labor Transactions form opens. 

 Select H-CUT from the Work Center drop-down list. 

 Select 12 from the Employee drop-down list. 

 Type 2 in the Total Hours field. 

 Click Process. A dialog box opens with the message, “[Post] was successful.” 

 Click OK. 

 Select H-CUT from the Work Center drop-down list, if it is not already selected. 

 Select 10 from the Employee drop-down list. 

 Type 2 in the Total Hours field. 
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 Click Process. A dialog box opens with the message, “[Post] was successful.” 

 Click OK. 

 Select H-CUT from the Work Center drop-down list, if it is not already selected. 

 Select 11 from the Employee drop-down list. 

 Type 2 in the Total Hours field. 

 Click Process. A dialog box opens with the message, “[Post] was successful.” 

 Click OK. 

 Select H-CUT from the Work Center drop-down list, if it is not already selected. 

 Select 7 from the Employee drop-down list. 

 Type 2 in the Total Hours field. 

 Click Process. A dialog box opens with the message, “[Post] was successful.” 

 Click OK. 

 Close the Work Center Labor Transactions form. 

 

 

_____________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 

 
_____________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 
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End-of-period costing 

Labor, materials, and machine hours per work center are accumulated on the Work Center form -  Accum 
Amt tab (accumulated amounts) when you post just-in-time transactions, complete quantities per 
production schedule, or work center transactions for labor, machines, and materials. 

 

Backflushing uses the production schedule routing to calculate materials and hours. If you report 
production through a JIT transaction, backflushing uses the current routing for the item. 

End of Period Costing activity 

After you have done all of the processing for your repetitive transactions for a specific period of time, end-
of-period costing needs to be ran. The time period for which to run the end of period costing activity is 
user-defined. It can be daily, weekly, or monthly.  

 

Starting Work Center – The first work center of a range of work centers to include in this process is 
entered in this field. 

Ending Work Center – The last work center of a range of work centers to include in this process is 
entered in this field. 

Post Through – The most recent date of the transactions you want to include in this process should be 
entered in this field or you can accept the default of the current date. 

Transaction Date – The date you want assigned to transactions as a result of running the End of Period 
Costing activity is entered in this field or you can accept the default of the current date. 

 

When finished, clicking Process will complete the activity. 

 

This activity reconciles the differences between the work centers' earned costs (all goods a work center 
produced during the period, the volume of materials and hours that should have passed through the work 
center, and the costs of that volume) and actual costs (the actual volume of materials and hours spent on 
the work center, and the costs of that volume). 

 

From this reconciliation, the system determines the cost variances and posts them to their respective 
variance accounts. 

 

Cost performance measurements emphasize production costs for the work center, but do not provide 
detailed measurements for particular production schedules, JIT transactions, or their routings and end 
items. 

 

Caution: While this process runs, you can enter transactions for production and backflush WIP-related 
costs to the work centers. If transaction dates for these postings fall before or during the Post Through 
date, the End of Period Costing activity may catch some of the WIP costs for those transactions, but not 
all of the WIP (depending on the timing). Also, actual values may not balance with earned values, causing 
variances to be larger than expected. If you run the End of Period Costing activity for the same period or 
the next period, all timing variances will wash out. 
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If an error occurs during the process, all processing for the work center is undone. The system continues 
to process the other work centers that meet the selection criteria. 

 

 

_____________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 

 
_____________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 

 
_____________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 
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Check your understanding 

 

For repetitive manufacturing, list the four transactions that can be posted directly to a work 
center, independent of the production schedule transactions. 

 

_______________________________________________________________________ 
 
_______________________________________________________________________ 
 
_______________________________________________________________________ 
 
_______________________________________________________________________ 
 
_______________________________________________________________________ 
 
_______________________________________________________________________ 
 
_______________________________________________________________________ 
 
_______________________________________________________________________ 

 

 

Which routing is used for backflushing of materials and time for production reported 
through just-in-time production transactions? 

 

a) Current routing 
b) Job routing 
c) Production schedule routing 
d) Standard routing 

 

 

True or false. When work center transactions are processed, the variance accounts are 
updated for each transaction at the time they are processed.  

 

a) True 
b) False 
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Course summary 

Estimated time 

30 minutes 

Course objectives 

Now that you have completed this course, you should be able to: 

 Describe how to set up the parameters required for repetitive manufacturing. 

 Discuss how to maintain the work center records. 

 Describe how to set up the criteria required for production items and component materials for 
repetitive manufacturing. 

 Describe how to copy and manipulate routings and bills of material. 

 Explain how to generate production schedules. 

 Describe how to update production schedules. 

 Explain how to manage the supply of floor stock locations. 

 Describe how to record production schedule transactions. 

 Describe how to record just-in-time production and work center transactions. 

Topics 
 Course review 
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Course review 

 

Repetitive manufacturing production control is supported by which module? 

 

a) Projects 
b) Production schedules 
c) Job orders 
d) Inventory management 

 

 

Where are repetitive manufacturing production costs accumulated? 

 

a) Production item record 
b) Job operations 
c) Floor stock location 
d) Work center 

 

 

Which costing method is used for repetitive manufacturing? 

 

a) Actual 
b) Average 
c) Weighted average 
d) Standard 

 

 

Why is it important that the WIP, variance, and overhead account numbers be set up for 
work centers under repetitive manufacturing?  

 

a) Production costing is done at the work center level 
b) Those accounts can only be used for work centers.  
c) The account number fields are required fields.  
d) None of the above. 

 

 

What backflush options are available on the Work Centers form? Select all that apply. 

 

a) Labor 
b) Machine 
c) Both  
d) Neither 
e) Material 
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Where is a floor stock location set up? 

 

a) Items form 
b) Item Stockroom Locations form 
c) Locations form 
d) Work Centers form 

 

 

Which of the following terms completes this sentence? A floor stock location must be 
associated to _____________ for floor stock replenishment to work. 

 

a) a production schedule 
b) a bill of material 
c) a job order 
d) a work center 

 

 

Place the four levels of backflush locations below into the proper order in which the system 
will check them to find a location to use when backflushing materials. Place a number (1 – 
4) to the left of each level to indicate the sequence in which they are checked for a valid 
backflush location. 

 

___  Item location that references the operation’s work center 

___   Control tab of the Items form 

___  Inventory parameters form 

___   Materials form 

 

 

Which of the following are used to manage the number of operations backflushed by a 
single transaction? 

 

a) Control points 
b) Inventory parameters 
c) Shop control parameters 
d) Work center resources 

 

 

A routing control point is specified on which form? 

 

a) Items form 
b) Operations form 
c) Work Centers form 
d) Both the Operations and Work Centers forms 
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Which parameter on the Inventory Parameters form must be selected in order for 
backflushing to be used? 

 

a) Low-Level On Line 
b) Inventory LCL% 
c) On-Hand Neg Flag 
d) Issue by Location 

 

 

Which of the following location types cannot be used for a backflush location? Select all 
that apply. 

 

a) Floor stock location 
b) Item Stockroom location 
c) Non-nettable location 
d) Transit location 

 

 

The value of which field on the Current Operations form determines whether the Pieces 
per Labor Hour or Pieces per Machine Hour field is used? 

 

a) Yield 
b) Use Offset 
c) Run Duration 
d) Sched Driver 

 

 

Which of the following terms completes this sentence? On the Current Operations form, 
the ____________ field displays the processing time (adjusted for efficiency) for the 
operation. 

 

a) Yield 
b) Pieces per Machine Hour 
c) Run Duration 
d) Sched Driver 

 

 

Which of the following terms completes this sentence?  The Pieces per Hour fields on the 
Operations form refers to the number of pieces produced per _____________. 

 

a) Resource hour 
b) Hour 
c) Labor Hour 
d) Hour average 
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Which of the following utilities are used to create a standard bill of material (BOM)? Select 
all that apply. 

 

a) Current BOM Cost Roll Up 
b) Roll Current Cost to Standard Cost 
c) Copy Routing BOM 
d) Current Bill of Material Processor  
e) Job and PS Bill of Material Processor 

 

 

A standard BOM can be created in the same manner as a current BOM. 

 

a) True 
b) False 

 

 

Place the activities below in the proper order for creating and using a production schedule. 
Place a number (1 – 5) to the left of each activity to indicate the sequence in which they 
should be performed. 

 

___  Enter production schedule items. 

___   Enter production schedule routings and BOMs. 

___  Create a production schedule header. 

___   Enter production schedule transactions. 

___   Enter production schedule releases. 

 

 

Changes made to production schedule release routing/BOMs are not synchronized to the 
corresponding production schedule item routing/BOM and vice versa. 

 

a) True 
b) False 

 

 

Which form is used to determine the quantities of materials needed at a floor stock location 
pending production, and can be used to post a move transaction to the floor stock 
location? 

 

a) Miscellaneous Issue form 
b) Material Transactions form 
c) Quantity Move form 
d) Floor Stock Replenishment Report form 
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Which of the following forms are used to record production schedule transactions? Select 
all that apply. 

 

a) Production Schedule Complete Transactions 
b) Post Job Transactions 
c) Job and PS Bill of Material Processor 
d) Production Schedule Scrap Transactions 

 

 

Which of the following statements completes this sentence? If you record quantities 
complete for a production schedule item at a control point operation, __________ will also 
have those quantities recorded as complete. 

 

a) all other control points in the same routing 
b) prior operations in the routing tied to that control point 
c) all operations in the routing 
d) no other operations 

 

 

Production schedule complete quantities and scrap quantities must both be recorded only 
for operations that are designated control points. 

 

a) True 
b) False 

 

 

Which report shows the released, completed, and scrapped quantities of production 
schedule items by release, and also shows cumulative totals of those quantities? 

 

a) Work Center Transactions Report 
b) Production Schedule Transaction Report 
c) Cumulative Production By Item Report 
d) Production Schedule Report 

 

 

During production of an item under a production schedule release, each member of the 
crew worked two additional hours on one day to get caught up with production 
requirements. Where should the additional labor hours be recorded? 

 

a) Each crew member’s employee time sheet with the production schedule ID recorded 
for the overtime entry 

b) Production schedule item release routing operation by increasing the resource group 
quantity for that operation  

c) Work Center Labor Transactions form for the work center associated to the routing 
operation where the labor was used 

d) Production Schedule Complete Transactions form when recording items complete for 
the routing operation where the labor was used 
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What kind of transaction is used to record production only when the production item is 
finished and ready to move into inventory? 

 

a) Production schedule complete transaction 
b) Just-in-time production transaction 
c) Job order transaction 
d) Work center material transaction 

 

 

What are the types of work center transactions that can be posted to a work center when 
production schedule transactions cannot be used? Select all that apply. 

 

a) Scrap 
b) Labor 
c) Machine Time  
d) Material  

 

 

If a component material for a production schedule item is serial number tracked, how is 
that material issued to the production line? 

 

a) Directly to the work center using the Work Center Material Transactions form 
b) Through backflushing when completed production items are recorded.  
c) Directly to finished good using the Just In Time Production Transactions form 
d) Through material adjustments after the finished good are moved to inventory.  

 

 

 

 

 



 

128 Appendix A: Review scenario  
 © 2016 Infor Education 

Appendix A: Review scenario 
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Instructions 

 

Scenario: Set up repetitive manufacturing of a new production item to 
be controlled using a production schedule  

In this scenario, you will practice performing the setup of a new item to be produced using 
repetitive manufacturing processes. You will then release production schedule lines and 
enter production schedule transactions for completed and scrapped quantities. 

This scenario does not include detailed steps so that you have the opportunity to apply the 
knowledge and skills you have learned in this course and in related courses. You are 
encouraged to experiment in this scenario as a means to better understand system 
behavior. Here is the information you will need to complete these tasks. 

Progressive Cycle's marketing department has been conducting several surveys regarding the 
performance of both upright and racing handlebars. The results, thus far, have been good. The upright 
handle bar meets the needs successfully of those customers who enjoy leisurely riding. The racing 
handle bar is successful with those riders who enjoy a leisurely ride as well as an occasional race. 
However, the marketing area has discovered that the racing handle bar is not meeting the needs of the 
cyclist who is strictly looking for high performance in racing competitions. Although this is a small market 
segment, marketing has decided that Progressive Cycles needs to satisfy these customers in order to 
stay competitive. 

Manufacturing and Engineering have been working diligently and have developed a new product to 
satisfy this new market segment. The new handle bar will be the TA-32000, High Performance Racing 
Handle Bar, and will be manufactured using production schedules. This new handle bar will consist of a 
new lighter weight aluminum material, the ZAL-250. 

 Create items 

Enter the two new items in the Items with the following information: 

Item Descriptio
n 

Stocked Type Source U/M Product/C
ode 

TA-32000 Handle-
Bar, High 

Performan
ce 

No Material Manufactu
red 

EA FG-200 

ZAL-250 Aluminum,
tube,1/ 

16",3/4"dia 

Yes Material Purchased FT PP 

Go to the Items form - Controls tab for the ZAL-250 and select the Backflush check box and enter H-CUT 
as the backflush location. 

Remember, in order to produce the TA-32000 with repetitive manufacturing it must have a cost type of 
standard. Make sure the Cost Type field for the TA-32000 is “Standard” on the Items form - General tab. 

We are not concerned with all of the other fields on the Items form – General tab (for this scenario) for our 
initial start-up of our new high performance handle bar. 

After studying the new handle bar design, manufacturing has decided that the new high performance 
handle bar can be produced in the same cell as the TA-30000 and TA-31000, the “Handle Cell.” 

Go to the Items form - Planning tab and update the TA-32000's rate per day to 20. 

 Create current BOM 
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Because the TA-32000's process is almost identical to the TA-30000 and TA-31000, we can use the 
Copy Routing/BOM activity to create our routing. Update the Copy Routing/BOM form with the following 
information: 

Copy From Current 

Item TA-31000 

Labor, Material, or Both Labor 

 

Copy To Current 

Item TA-32000 

 

By selecting Labor, for the Labor, Material, or Both field, we will only be copying TA-31000's routing and 
not the Bill of Material. 

Don't forget to process the activity! 

Go to Operation 20 for the TA-32000 and add the following text as a note: 

“Please adhere to the specifications on Engineering's drawing for the TA-32000 so that this new 
aerodynamic design will be achieved.” 

Now that the routing is complete we must add our new material, the ZAL-250, to Operation 10 of the TA-
32000's routing. The quantity will be 2ft. This material will be backflushed from our H-Cut location. 

 

 Create standard BOM 

The final phase of setup will be to create our standard routing. Use the Roll Current to Standard Utility to 
create our new standard routing. The TA-32000 should be entered as the starting and ending item and 
the Post Change check box should be selected. 

For this exercise, we are not concerned with the costing aspects of repetitive manufacturing. However, 
this utility must be run before any repetitive transactions can occur for the TA-32000. 

 

 Create production schedule 

Now that everything is in place we can create a production schedule so that we can begin producing our 
new high performance handle bar. 

Production will begin one week from this coming Monday. Use the following chart to fill in that week's 
appropriate dates: 

Monday         /       /          

Tuesday        /       /          

Wednesday        /       /          

Thursday        /       /          

Friday         /       /          

 

Using the generate production schedule activity, create production schedule releases backward from next 
Friday for the TA-32000. Create one release each day for a total quantity of 100 units. The Rate/Day 
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should be 20 and the status should be Released so that the production schedule routing and bill of 
material will be created. The Schedule ID should be "200." 

Don't forget to process the activity! 

Review the production schedule and the production schedule routing/BOM. 

Review the production of the TA-32000 on the Cell Production form for the Handle Cell. Make sure the 
appropriate dates are entered. 

 

 Run floor stock replenishment 

To prepare for the production of the TA-32000, run the Floor Stock Replenishment Report for the Handle 
Cell. Enter item ZAL-250 as the Starting and Ending Item. Once the requirements are known, process a 
miscellaneous receipt for the correct quantity into the H-Cut location. 

Normally a purchase order would be required to obtain the ZAL-250. 

The Floor Stock Replenishment Report should show total requirements of 200ft for the ZAL-250. 

It is now Monday, the first day of production for the TA-32000. View the Cell Dispatch form for the Handle 
cell with Monday's date. 

Post transactions 

The following production tickets were written by the Handle supervisor regarding the production of the TA-
32000. 

HANDLE BAR CUTTING WORK CENTER 

Part Completed Scrapped Reason Locations 

TA-32000 18 2 Mfg. Process --- 

 

HANDLE BAR FINISHING WORK CENTER 

Part Completed Scrapped Reason Locations 

TA-32000 18 --- --- Stock 

 

Enter and post the above transactions. 

Monitor production 

Review the Production Schedules form to view the reported quantities. 

Run the Production Schedule Operation Status report and the Cumulative Production by Item report to 
review the above transactions. 
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Reports 

Cumulative Production by Item Report 

This report displays released, completed and scrapped quantities by item as well as cumulative quantities 
for the same time period. A bin size can be selected to display the output in daily, weekly or monthly 
increments. 

Material Use Up Report 

This report helps to determine the best date to change a part in a bill of material. In many cases, you 
might want to use up the current inventory of a part before you replace it with a new part. With this report, 
you can either calculate when the quantity will reach zero, or calculate the remaining quantity at a 
selected break date. 

Once the report is run, the following fields are populated and buttons enabled: 

 On the Current Materials form: Est Break Date and Date of Last Rpt fields, and a Matl Use Up 
Report button 

 On the Items form: fields on the Matl Use Up tab 

 On the Engineering Change Notice Items form: Est Break Date, Date of Last Rpt, Matl Req 
Date, Change Type, and Notify Customers fields 

Production Schedule Earned Cost Report 

The Production Schedule Earned Cost Report displays the accumulated costs from production schedule 
complete transactions where you have moved items into inventory. The report includes information on 
Labor Analysis, Material Analysis and Production Cost Analysis. 

Production Schedule Operation Status Report 

This report displays the status of all operations for all production schedule releases. Released, 
Completed, and Scrapped quantities are shown for each operation.  

Production Schedule Report 

This report provides a listing of production schedule releases, their status, the date they are to be 
manufactured and the released, completed, scrapped and remaining quantities. 

Production Schedule Routing Report 

This report displays the routing and bills of material for a production schedule and item combination. 

Production Schedule Scrapped Report 

This report provides summary information to assist in tracking scrapped quantities that have been 
reported against production schedule operations. 

Production Schedule Transaction Report 

The Production Schedule Transaction Report displays the scrap that has been reported from production 
schedule scrapped transactions. It provides summary information to assist in tracking the status of 
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production schedules and identifies completed quantities that have been reported against production 
schedule operations. 

Material Transactions Report 

The Material Transactions Report provides summary information to assist in tracking the quantity and 
location of items that have been reported through JIT and production schedule transactions. 
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Utilities 

Change Production Schedule Release Status 

This utility allows the user to perform multiple changes to the status of production schedule releases. 
Valid status changes are: 

 Planned to Released 

 Released to Completed 

 Completed to Released (to make this change, the status of the production schedule must be 
Released) 

Delete Production Schedule Releases 

This utility deletes a specified range of releases within a production schedule. Releases must have a 
status of Planned or Complete for this utility to delete them. 

Job and PS Bill of Material Processor 

This utility updates the low level codes of all items in the job and production schedule BOMs. 

 

 



 

136 Appendix D: Summary of planning tools  
 © 2016 Infor Education 

Appendix C: Additional implementation 
information 
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Operations 

Current operations 

An item that is produced on a production line represents a balanced flow of product from operation to 
operation. Therefore, the current operations that make up this production line should represent this 
balanced flow. That is to say, the rate per hour for each operation in the production line should be the 
same. Even though a given work center may have the potential to produce at a higher rate per hour, the 
rate per hour of that work center should be set to that of the production line. 

Offset hours in current operations 

Since a production line has a balanced flow, as soon as the first item is completed at the first operation, 
the product is passed to the next operation, and so on. The time that it takes to fill the line so that there is 
a part at each operation is insignificant. The Offset Hours for each operation in a production line should 
be set to zero. This will represent simultaneous production through each operation. This best represents 
a production line. 

Setup hours in current operations 

If setup hours are specified in the routing for a production schedule item, these setup hours are included 
in the scheduling of each production schedule release. Since setup is minimal or non-existent in a 
production line, the setup hours for most items should be set to zero. 

Master production schedules 

The Rate/Day field for an item is closely related to the Days Supply, Order Minimum, and Order Multiple 
fields on the master production schedule. The user must carefully consider the relationship between 
these fields so that the master production schedule firming process will logically produce valid production 
schedules. 
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Control point logic 

Control points are the areas in the manufacturing facility where production reporting transactions are 
generated. 

Multiple operations may be controlled by a single control point. The logic used to determine which 
operations are controlled by a control point is as follows:  

All operations following the prior control point, or starting with the first operation if no prior control points 
exist, up to and including the control point operation itself 

 

The following is what happens during the posting process for a control point transaction: 

 Each operation controlled by the control point will be processed in turn, starting with the lowest 
operation number. 

 All materials that are marked for backflushing will be backflushed. 

 Scrap factor will always be applied to backflushed material issues. 

 All labor, on operations with the Backflush field set to "Labor" or "Both", will be backflushed. 

 All machine hours, on operations with the Backflush field set to "Machine" or "Both," will be 
backflushed. 

 Appropriate overheads (material, machine, labor) will be calculated and posted. All calculated and 
posted amounts will be based on either the job routing and bill of material, production schedule 
routing and bill of material, or the current routing and bill of material depending on the transaction 
types used. 
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Reverse backflushing 

Reverse backflushing will occur whenever negative quantities are completed on a job, production 
schedule, or just-in-time production transaction. Reverse backflushing may occur on multiple operations 
at a time, when negative quantities are completed for a control point. 

When reverse backflushing materials, the cost of materials leaving the job will be based on the average 
cost of the materials issued to the job. 

When reverse backflushing labor hours or machine hours, the rate (cost) of the hours being subtracted 
will be based on the job routing, production schedule routing, or the current routing, depending on the 
method of manufacture. 

Reverse backflushing can only back out a maximum of 100% of total WIP. Reverse backflushing will not 
reduce WIP to negative amounts. 

Backflushing does not relieve additional secondary or tertiary locations. If the On Hand Neg Flag check 
box on the Inventory Parameters form is selected, the system will take location inventory below zero. 

Backflushing occurs when production is reported (quantities are completed and/or scrapped). 
Backflushing will not occur when manually changing the status of an operation to "Complete" or when 
running the Complete Job Operations utility. 

Lot tracked and/or serial tracked items will not be backflushed. 

Manual transactions for labor, machine time, and materials will be independent of backflushed 
transactions. Backflushing will be based solely on the quantity complete and scrapped on an individual 
transaction, ignoring any manual or backflushed amounts already posted.  

For example, if the user inputs a manual transaction for a material issue of 100, and the material is also 
set to be backflushed, and then reports a quantity complete of 100, the system will backflush 100 and 
now 200 units will have been issued. 

Costs and quantities associated with backflushed transactions will come from the job routing and bill of 
material, production schedule routing and bill of material, or the current routing and bill of material 
depending on the method of manufacture. 
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What are the main planning tools? 

There are three general ways to figure out what you need to make and when: 

 Time-phased netting of supply and demand 

 Simple netting of supply and demand 

 Hard peg of supply to demand 

The system provides a number of tools you can use to support these methods. 

Planner running in MRP mode (MRP)  

Note: Other tools used include the material planner’s workbench, planning detail display, and the 
Analyzer. 

Planner running in APS mode (APS)  

Note: Other tools used include the material planner’s workbench, planning detail display, and the 
Analyzer. 

Time phased inventory status (TPIS) form  

Purchase requirements report (PRR)   

Material availability report (MAR) 

Material planner’s workbench: inventory below safety stock (MPW: IBSS) 

Material planner’s workbench: Xref (MPW: Xref) 

In this appendix we will summarize these tools and how they inform us what to manufacture and when. 

The table below shows the key aspects of each tool and the general method it supports. 

General Method 1 2 3 

Calculation... MRP APS TPIS MAR PRR MPW: 
IBSS 

MPW: 
Xref 

Automatically generates 
supply orders 

Yes Yes No No No Yes Yes 

Generates supply orders to 
meet due dates 

Yes Yes No No No No No 

Displays inventory levels 
over time 

Yes Yes Yes No1 Yes No No 

Includes planned orders Yes Yes No No No No No 

Considers capacity Yes Yes No No No No No 

Constrains on capacity No Yes No No No No No 

Soft-pegs supply to 
demand 

Yes Yes Yes Yes Yes Yes No 

Hard-pegs supply to 
demand 

No No No No No No Yes 

Prevents planning before 
today 

Yes Yes No No No No No 
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General Method 1 2 3 

Calculation... MRP APS TPIS MAR PRR MPW: 
IBSS 

MPW: 
Xref 

Backwards plans Yes Yes No Yes No No Yes 

Requires BOMs Yes Yes No Yes No No No2 

1It does use lead time and report shortages based on calculated need dates. 

2It does require BOMs if you want to create job/sub-job Xref structure. 
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MRP and APS 

The planner lets you know which orders to create and when by providing planned orders with release and 
due dates. The planner works in real time--every demand order is planned as it is entered into the 
system. You can also get real time available-to-promise (ATP) or capable-to-promise (CTP) information at 
the time of order entry. Other non-order inputs are updated on a nightly basis. 

This tool is superior in all environments except those where you lack BOM data. 

The planner uses the same algorithms for each mode. The only differences between the two modes are 
the constraints. 

Constraint MRP APS 

Material Constrains Constrains 

On-shift lead time Constrains Constrains 

Capacity Does not constrain Constrains 

You view, modify, and firm up these planned orders using the material planner’s workbench. 

Material Planner Workbench Generation form 

You use this generation activity to copy a subset of all the planned orders to the workbench. 

 

Material Planner Workbench Generation form 

Note: The Order Action Report provides the same information in hard copy. 

  



 

144 Appendix D: Summary of planning tools  
 © 2016 Infor Education 

Material Planner Workbench form 

On the workbench, you review, modify, delete, and firm up planned orders. 

 

Material Planner Workbench form 

Planning Detail form 

You can use the planning detail display to see a time-phased view of inventory levels as well as parent 
orders and exception messages. You can also firm up planned orders. You will probably find that the 
workbench gives you more flexibility and control. 

 

Planning Detail form 

For more information on the planner, see the Planning Training Workbook. 
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Master Production Schedule form 

 

Master Production Schedule form 

The Master Production Schedule (MPS) form is a collection of planned orders that have been manually 
created for key items. The user sets up these orders on the Master Production Schedule form using the 
MPS Processor activity. 

You can use the Material Planners Workbench to firm MPS orders into job orders, production schedule 
releases, purchase orders, and transfer orders just as you do when firming planned orders created by the 
planner in MRP or APS mode. 

MPS items are not planned by the planner in MRP or APS mode. However, the planner will plan for the 
items that are in the MPS item's BOM. 
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Time Phased Inventory Status form 

The Time Phased Inventory Status helps you determine what and when to make an item by providing a 
view of inventory levels for an item over time. You would create orders for periods where you see 
inventory drop below an acceptable level. It is similar to the planning detail display but is does not include 
planned orders. 

This tool is useful in repetitive environments with a manageable product mix. However, if you have BOM 
data, you will get more helpful data by using the planner. 

The projected on-hand quantities are calculated from the following: 

Order type Status 

Customer orders Planned, Ordered 

Purchase orders Planned, Ordered 

Job orders Firm, Released 

Transfer orders Ordered, Transit 

Notice that the form displays for each requirement or receipt, the need or supply date, projected inventory 
levels, the order information, and the customer (for customer orders) or vendor (for purchase orders). 

If you highlight a line and click the X-Ref button, the system will open the order form for the order 
displayed in the Reference field. 

 

Time Phased Inventory Status form 
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Material Availability Report form 

The Material Availability Report form helps you determine the quantities available to promise (ATP) on a 
specified date. It informs you of all of the materials you will have shortages for on that projected date. If 
there are projected shortages, the report also projects the date on which you would be able to fill the 
order based on the critical path lead time through all levels of the BOM. 

The report is also used in two other situations: 

To verify that you have all material necessary before releasing jobs to the floor 

To calculate a basis for MPS fence times 

This tool is useful when you just want a rough idea of whether or not you can meet a demand. However, 
you can get more accurate data using the Planner's Get ATP/CTP function. 

 

Material Availability Report form 

Form fields: 

Date Required 

This field shows the expected completion date for the job. 

Use Safety Stock 

This field identifies if the safety stock is considered available material. If selected, it indicates that it is 
available. If cleared, it subtracts the quantity from on hand when determining availability. 

Include Released Jobs 

If selected, it will increase the quantity on hand by any released jobs that are scheduled to be completed 
prior to the date required. 
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Include Ordered PO's 

If selected, it will increase the quantity on hand by any ordered purchase orders that are due prior to the 
date required. 

Subtract Allocations from On Hand 

If selected, any allocations to jobs or customer orders will be subtracted from on hand quantities when 
determining availability. 

 

Material Availability Report – sample output 

Report output fields: 

Qty Available 

Availability status is given as the quantity required, quantity available, and the date required. 

 

The quantity availability is determined by the current quantity on hand minus any allocations, with an 
option to include released jobs and/or purchase orders. If a shortage exists, the amount of shortage is 
given as well as an order date. 

Critical Path Lead Time 

Lead time required through all levels of the BOM to make this item. The report looks at each level of the 
BOM, determines which material at that level has the longest lead time, and then adds those material 
lead times together to get the critical path lead time. 

ASAP Date 

This is the current date plus the critical path lead time. The calculated "as soon as possible" date is based 
on forward scheduling given the availability of components. This takes into consideration both purchasing 
and manufacturing lead times. Resource capacity is not considered. 
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To locate available on-hand quantities from released jobs and ordered purchase 
orders, run the Purchase Requirements Report for the items in question.  

The job scheduled end date and the purchase order line/release due date will display 
the quantities that will be available by the Material Availability Report order date. 



 

150 Appendix D: Summary of planning tools  
 © 2016 Infor Education 

Purchase Requirements Report 

The Purchase Requirements Report helps you determine what to make and when by identifying 
displaying every item (manufactured, purchased, or transferred) for which an order should be placed to 
prevent the on hand quantity from going below safety stock. 

It is usually used as an interim tool while in environments where planners are learning how to use MRP. 
This tool is useful only when you want a rough idea of what you need to make to maintain inventory 
levels. If you have BOM data, you can get more helpful and accurate planning data with the planner. 

An item displays if the sum of its nettable quantities on hand, on order, and in process (On Hand, On 
Order, and Qty WIP fields) minus its quantities allocated to both orders and jobs (Alloc Job and Alloc Ord) 
is less than its safety stock quantity. The report will show the inventory levels over time and suggest a 
production quantity to bring the ending inventory level up to the safety stock level. 

 

This report displays requirements and replenishments. 

This input... Includes... 

Requirements Customer orders or Allocation To Prod 

Replenishments Purchase orders or work in process (the item 
being manufactured) 

There are different fields on the report depending upon whether a CO, a job, a WIP, or a PO is being 
displayed. 

 

Purchase Requirements Report form 
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Form fields: 

Time Phase Detail 

This field shows depletions and replenishments in date order. 

Show Depletions 

This field displays the source of each item's stock depletion. 

Show Replenishments 

This field displays the source of each items stock replenishment. 

Material Type, Source, and ABC Code 

These fields allow you to narrow your selection to items with the attributes you specify here. 

PS, Customer Order, PO, and Job Status 

These fields allow you to narrow your selection to only include order lines & releases with the statuses 
you select. 

Starting and Ending Warehouse, Item, Product Code, and Planner Code 

These fields allow you to narrow your selection to the ranges you specify here. 

 

Purchase Requirements Report – sample output 

 



 

152 Appendix D: Summary of planning tools  
 © 2016 Infor Education 

Material Planner Workbench: Inventory below safety 
stock 

The Material Planner Workbench (with an inventory below safety stock generation) helps you determine 
what and when to make an item by identifying whether the total demand for an item netted against the 
total supply for an item drives the inventory level below safety stock. 

If an item's final inventory level is below safety stock, then it will generate a planned order for that item 
that you can then view, modify, and firm up into an actual order. 

This tool is useful at distribution warehouses and can be used in conjunction with the Planner to meet 
their needs. 

Material Planner Workbench Generation form 

You use this generation activity to run the calculations. If you select the default warehouse as specified 
on the Inventory Parameters form, this activity will calculate the requirements for all warehouses. In all 
other cases it will calculate requirements for only the warehouse that you specify. 

 

Material Planner Workbench Generation form 

Once you've generated planned orders, you can use the workbench to view, modify, and firm the orders. 
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Inventory Below Safety Stock Report form 

You can view the same information in hard copy using the Inventory Below Safety Stock Report form. 

 

Inventory Below Safety Stock Report form 

 

Inventory Below Safety Stock Report – sample output 
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Appendix E: Form navigation 
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Where to find repetitive manufacturing forms 

The table below lists a variety of forms that are useful for repetitive manufacturing. The navigation path to 
each form is also listed. 

Form title Navigation path 

Change Production Schedule 
Release Status 

Production > Work Centers > Utilities 

Copy Production Schedules Production > Production Schedules > Activities 

Copy Routing BOM Production > Production Schedules > Activities 

Current Materials Material > Product Definition 

Current Operations Material > Product Definition 

Delete Shift Exceptions Production > Work Centers > Utilities 

Departments Employee > HR > Organization 

Engineering Workbench Material > Product Definition 

Floor Stock Replenishment 
Report 

Production > Work Centers > Reports 

Generate Production Schedules Production > Production Schedules > Activities 

Inventory Below Safety Stock 
Report 

Material > Inventory > Reports 

Inventory Parameters Codes > Parameters 

Items Material > Inventory 
 

Material > Product Definition 

Items to Be Completed Report Production > Scheduling > Reports 

Just-in-Time Production 
Transactions 

Production > Production Schedules > Activities 

Lead Time Processor Material > Inventory > Utilities 

Locations Material > Inventory 

Master Production Schedule Material > Planning 

Material Availability Report Production > Work Centers > Reports 

Order Action Report Material > Planning > Reports 

Order Status Report Customer > Order Entry > Reports 

Product Codes Inventory > Files 

Production Exceptions Report Production > Scheduling > Reports 

Production Schedule Complete 
Transactions 

Production > Production Schedules > Activities 

Production Schedule Items Production > Production Schedules 

Production Schedule Materials Production > Production Schedules 
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Form title Navigation path 

Production Schedule Operations Production > Production Schedules 

Production Schedule Scrapped 
Transactions 

Production > Production Schedules > Activities 

Production Schedules Production > Production Schedules 

Purchase Requirements Report Vendor > Purchase Orders > Reports 

Resource Groups Production > Work Centers 

Resources Production > Work Centers 

Shop Floor Control Parameters Codes > Parameters 

Time Phased Inventory Status Material > Inventory 

Work Center Labor Transactions Production > Work Centers > Activities 

Work Center Machine 
Transactions 

Production > Work Centers > Activities 

Work Center Material 
Transactions 

Production > Work Centers > Activities 

Work Centers Production > Work Centers 
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